IDENTIFICATION OF PERIPHERALS OF A PC, LAPTOP, SERVERAND SMART
PHONES:

COMPUTER:

Computer is an advanced electronic device that takes raw data as input from the user and processes it

under the control of set of instructions (called program), gives the result (output), and saves it for the

future use.
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Pcnpheral Devices

1. Input Unit: This unit contains devices with the help of which we enter data into computer. This unit
makes link between user and computer. The input devices translate the information into the form
understandable by computer.

2. Output Unit: 0utput unit consists of devices with the help of which we get the information from
computer. This unit is a link between cornputer and users. Output devices translaté the computer's output
into the form understandable by users.

CPU (Central Processing Unit): CPU is considered as the brain of the computer. CPU performs all
types of data processing operations. It stores data, intermediate results and instructions (program). It

controls the operation of all parts of computer.
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CPU itself has following three components
¢  ALU(Arithmetic Logic Unit)
e Memory Unit

* Control Unit

3. Memory or Storage Unit: This unit can store instructions, data and intermediate results. This unit
supplies information to the other units of the computer when needed. It is also known as internal storage
unit or main memory or primary storage or Random access memory (RAM).
Its size affects speed, power and capability. Primary memory and secondary memory are two types of
memories in the computer.
Functions of memory unit are:

» It stores all the data and the instructions required for processing.

» It stores intermediate results of processing.

» All inputs and outputs are transmitted through main memory.

4, Control Unit: This unit controls the operations of all parts of computer but does not carry out any
actual data processing operations.
Functions of this unit are:
» It is responsible for controlling the transfer of data and instructions among other units of a computer.
» It manages and coordinates all the units of the computer. .

» It communicates with Input/output devices for transfer of data or results from storage.

5. ALU (Arithmetic Logic Unit): This unit consists of two subsections namely

i. Arithmetic section

ii. Logic Section
i. Arithmetic Section: Function of arithmetic section is to perform arithmetic operations like addition,
subtraction, multiplication and division. All complex operations are done by making repetitive use of
above operations. _
ii. Logic Section: Function of logic section is to perform logic operations such as comparing, selecting,

matching and merging of data.

PC: A personal computer is a computer small and low cost, which is intended for personal use
(or for use by a small group of individuals). The term "personal computer” is used to
describe desktop computers (desktops). It is often shortened to the acronym PC or
microcomputer, whose meaning in English is "personal computer”. It is a very common type of

machines.
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Personal Computer.(acronym -PC) consists of a central processing unit (CPU) contains the
arithmetic, logic, and control circuitry on an single (IC) integrated circuit; two types of memory,
main memory, such as RAM, and ROM, magnetic hard disks (HDD) and compact discs and
various input/output devices, including a display screen, keyboard and mouse, modem,

and printer.

------- Output Devices:

Motherboard: A motherboard is one of the most essential parts of a computer system. It holds together

many of the crucial components of a computer, including the central processing unit (CPU), memory and

connectors for input and output devices. ;
Northbridge

with heat sink Southbridge

; PO siots

CPU heat sinks IR : 2 :
points for fans

CPU socket

‘\t\ connecton for peripherals (2. audio,
Ethernet, serial port, USS, etc.}

RAM is an acronym for random access memory, a type of computer memory that can be
accessed randomly; that is, any byte of memory can be accessed without touching the preceding
bytes. RAM is found in servers, PCs, tablets, smartphones and other devices, such as printers.
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a power supply unit or PSU, the component that supplies power to a computer. Most
personal computers can be plugged into standard electrical outlets. The power supply then
pulls the required amount of electricity and converts the AC current to DC current.

CPU (pronounced as separate letters) is the abbreviation for central processing unit. Sometimes
referred to simply as the central processor, but more commonly called a processor, the CPU is
the brains of the computer where most calculations take place.

a video card is an expansion card that connects to a computer motherboard. It is used to creates
a picture on a display; without a video card, you would not be able to see this page. More plainly,
it is a piece of hardware inside of your computer that deals with processing images and video,

along with some of the tasks normally handled by the CPU.
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oA hard disk drive (HDD), hard dis& hard drive, or fixed disk is an electro-mechanical, data storage
* device that uses magnetic storage to store and retrieve digital information using one or more rigid rapidly
rotating disks (platters) coated with magnetic material

SSD stands for Solid State Drive. The HDD or SDD is the hardware component in
a computer that stores data. The operating system (usually Windows on PCs and MacOS on
Apple computers) is installed on the drive

An Optical ‘Drive refers to a computer system that allows users to use DVDs, CDs and Blu-
ray optical drives. ... DVDs have a storage capacity of 4.7GB and can be used to store data for
various uses. For you to write content/data to a disc, you will need a blank recordable DVD disc
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A memory card reader is a device for accessing the data on a lhemory card such as a
CompactFlash (CF), Secure Digital (SD) or MultiMediaCard (MMC). Most card readers also
offer write capability, and together with the card, this can function as a pen drive.

Networking cables are networking hardware used to connect one network device to
other network devices or to connect two or more computers to share printers, scanners etc. ...
Electrical connections using twisted pair or coaxial cable are used within a building

LAPTOP

Laptop computers, or laptops, are portable computers that allow users to keep their data and
applications readily available as they travel between destinations. The focus up to now has been
on desktop computers, which are not designed for portability, and typically have larger hard
drives, larger RAM counts, and more sophisticated CPUs than laptops.
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Laptop Parts Functions

" Following table describes functions of some major laptop parts.
" pam - e e Functionaldescripﬁon

It functions similar to monitor used in desktop PC. It is known as output

“ device as it is used to display output to the user in desired format. There
are different display screens available as per various brands of the laptop

viz. SONY, HP, DELL, LENOVO, ACER, ASUS etc. The types include

i 80| LCD, LED, VGA, XVGA, CCFL etc. The display panel can be touch

screen type or non touch screen type. Touch screen allows users to

display choose from different options by simple touch with their fingers on
“ screen desired menu or icon displayed on the screen.
"__—_—w—_m—"_.'—',.._—-ﬁ ——e——— —_— ——
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keyboard

It is most common input device used to provide commands or data to the
laptop or computer. There are different types of keyboards based on keys
used and their layout arrangements. The common types are QWERTY,
QWERTZ, AZERTY and HCESAR. Various keys found on keyboards
include standard typewriter keys, function keys (F1, F2, F3, ..., F12)
special purpose keys (Ctrl, Del, Ins, Alt) , cursor movement keys,

numeric keys.

base panel

The base panel provides installation place for laptop parts which include
mother board, RAM, hard drive, cooling fan, battery, CD drive etc.

top panel

The top panel provides installation place and support for laptop screen.

Cooling

Fan

It cools down temperature of internal components such as CPU, GPU

etc.

RAM is the short form of Random Access Memory. It is the type of
memory which can be accessed randomly. It is temporary memory
which stores data and programs while they are being. used and requires
power source to maintain its integrity. Laptop computers use DDR -
SDRAM types which are double data rate synchronous dynamic random
access memory (RAM) class of memory ICs. The common types of
SDRAM include DDR1, DDR2, DDR3 and DDR4.

Hard disk

The laptop hard disk drives are of two common types viz. IDE (or
PATA) hard drive or SATA hard drive. They can be identified based on

interface available on them.

palm rest

assembly

It provides support to install keyboard, base panel and touchpad. It
covers the entire motherboard of the laptop so that any external dust or
water or things do not fall on electronic components of it. It allows place
to keep hands of the user in order to operate keyboard keys and

touchpad.
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Touchpad

* The touchpad or trackpad uses tactile sensor on specialized surface. The

touchpad is a pointing device which translates motion and position of
fingers on the surface to relative cursor position on the screen of
operating system installed in the laptop. It is most common feature of all

the laptops and used as substitute for mouse where desk space is limited.

Battery

It is used to provide power backup in order to operate laptop when AC
mains power is not available. The common laptop battery voltages are
10.8V, 11.1V or 14.8V. All the laptop batteries are rechargeable. The
common laptop battery types include lithium ion (i.e. Li-ion), nickel
cadmium (i.e. NiCad) and nickel metal hydride (i.e. NIMH). Out of these
Li-ion is being most commonly found in latest laptops. They are made

using various combination of cells viz. 3 cells or 4 cells etc.

Hinges

A hinge is type of object which connects two solid objects so that they
can be rotated with respect to each other with certain angle between
them. In laptop hinges provide laptop screen to be rotated with respect to
the base panel. This also helps screen to be completely reside or rest on
the laptop base panel when not in use.

Speaker

In general speaker is used to produce sound. Like external speakers, '
laptop speakers also allows user {0 control volume up or down as per
need. It is available in power ratings of 2.6 watt or 5 watt.

Optical

drive

Laptop optical drives can read/write CDs, DVDs or Blu-Ray discs.
These drives allow reading and recording of data at very high speeds.
One can also use external optical drives.

Antenna

Antenna provides wireless connectivity in the laptop for various
applications such as wifi internet, Bluetooth etc. Most commonly laptop

antenna operates either in WLAN frequency band or Bluetooth

frequency bands as per different standards or classes. - I '

SERVERSYSTEMS

Servers are computers that hold shared files, programs, and the network operating system.
Servers provide access to network resources to all the users of the network. There are many

different kinds of servers, and one server can provide several functions. For example, there are
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file servers, print servers, mail servers, communication servers, database servers, fax
servers and web servers, to name a few.

A server is a computer or system that provides resources, data, services, or programs to other
computers, known as clients. Server computers are usually built from higher grade components
than client computers for the reasons given in the preceding section.

Server

The following paragraphs describe the common components of a server computer:

Motherboard

The motherboard is the computer’s main electronic circuit board to which all the other
components of your computer are connected. More than any other component, the
motherboard is the computer. All other components attach to the motherboard.

The major components on the motherboard include the processor (or CPU), supporting circuitry
called the chipset, memory, expansion slots, a standard IDE hard drive controller, and
input/output (I/O) ports for devices such as keyboards, mice, and printers. Some motherboards

also include additional built-in features such as a graphics adapter, SCSI disk controller, or a

network interface.

Processor

The processor, or CPU, is the brain of the computer. Although the processor isn’t the only
- component that affects overall system performance, it is the one that most people think of first
when deciding what type of server to purchase. At the time of this writing, Intel had four
processor models designed for use in server computers:

Itanium 2: 1.60GHz clock speed; 1-2 processor cores
Xeon: 1.83-2.33GHz clock speed; 1-4 processor cores
Pentium D: 2.66-3.6GHz clock speed; 2 processor cores
Pentium 4: 2.4-3.6GHz clock speed; 1 processor core

10
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.Memory. .. - -
Don’t scrimp on memory. People rarely complain about servers having too much memory. Many
different types of memory are available, so you have to pick the right type of memory to match
the memory supported by your motherboard. The total memory capacity of the server depends on
the motherboard. Most new servers can support at least 12GB of memory, and some can handle
up to 32GB.

Hard drives

Most desktop computers use inexpensive hard drives called IDE drives (sometimes also
called ATA). These drives are adequate for individual users, but because performance is more
important for servers, another type of drive known as SCSI is usually used instead. For the best
performance, use the SCSI drives along with a high-performance SCSI controller card.

Recently, a new type of inexpensive drive called SATA has been appearing in desktop
computers. SATA drives are also being used more and more in server computers as well due to
their reliability and performance.

Network connection

The network connection is one of the most important parts of any server. Many servers have
network adapters built into the motherboard. If your server isn’t equipped as such, you'll need to
add a separate network adapter card. .

Video

Fancy graphics aren’t that important for a server computer. You can equip your servers with
inexpensive generic video cards and monitors without affecting network performance. (This is
one of the few areas where it’s acceptable to cut costs on a server.)

Power supply

Because a server usually has more devices than a typical desktop computer, it requires a larger
power supply (300 watts is typical). If the server houses a large number of hard drives, it may
require an even larger power supply. :

SMART PHONES

Smartphones are a class of mobile phones and of multi-purpose mobile computing devices.
They are distinguished from feature phones by their stronger hardware capabilities and
extensive mobile operating systems, which facilitate wider software, internet (including web
browsing!"! over mobile  broadband), and multimedia functionality  (including  music,
video, cameras, and gaming), alongside core phone functions such as voice calls and text
messaging. Smartphones typically include various sensors that can be leveraged by their
software, such as a magnetometer, proximity sensors, barometer, gyroscope and accelerometer,
and support wireless communications protocols such as Bluetooth, Wi-Fi, and satellite
navigation. : ' : :
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Display (Touch Screens)

While the display could be seen as an exterior element of a smartphone, it is also an interior one.
'As the principle method for interacting with our smartphones, it can be argued that it is the most
important component. Displays come in a variety of sizes with a whole gamut of screen
resolutions. The common sizes are between 4.5 to 5.7 inches (measured across the diagonal) and
the key screen resolutions are 1280 x 720, 1920 x 1080 and 2560 x 1440.There are two main
types of display technology: LCD and LED.

Battery

The electrical power for all the bits inside your smartphone comes from the battery. A
battery can either be user removable, which means you can easily replace it or carry multiple
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batteries with .you; or it can sealed into the phone, which means it can only be replaced by a
technician. The capacity of the battery is a key metric, with most 5.5 inch phones having at least
a 3000 mAh unit. When it comes to charging there is a whole spectrum of different charging
technologies, however the popular is probably Quick Charge from Qualcomm. Most smartphone
batteries today are Lithium-ion (Li-lon) based, which means you don’t need to worry about

things like the battery memory effect.

Central processing unit

Smartphone have central processing units (CPUs), similar to those in computers, but optimized
to operate in low power environments.

The performance of mobile CPU depends not only on the clock rate (generally given in
multiples of hertz)[123] but also on the memory hierarchy. Because of these challenges, the
performance of mobile phone CPUs is often more appropriately given by scores derived from
various standardized tests to measure the real effective performance in commonly used
applications.

Cameras

Cameras have become standard features of smart phones. As of 2019 phone cameras are now a
highly competitive area of differentiation between models, with advertising campaigns
commonly based on a focus on the quality or capabilities of a device's main cameras. All smart
phones come with a rear-facing and front-shooting camera

Accessories

A wide range of accessories are sold for smart phones, including cases, screen protectors, power
charging cables, wireless power stations, USB On-The-Go adapters (for connecting USB drives
and or, in some cases, a HDMI cable to an external monitor), add-on batteries, headphones,
combined headphone-microphones (which, for example, allow a person to  privately
conduct calls on the device without holding it to the ear), and Bluetooth-enabled powered

speakers that enable users to listen to media from their smart phones wirelessly.

Sensors

There are five main sensors in a smart phone that allow it to give you that functionality of a
‘touch-enabled smart device’. The names of all these sensors and their importance have been

detailed below:
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1. Accelerometer: Used by apps to detect the orientation of the device and its
movements, as well as allow features like shaking the phone to change
music. 5 X > E

2. Gyroscope: Works with the Accelerometer to detect the rotation of your
phone, for features like tilting phone to play racing games or to watch a
movie.

3. Digital Compass: Helps the phone to find the North direction, for
map/navigation purposes.

4. Ambient Light Sensor: This sensor is automatically able to set the screen
brightness based on the surrounding light, and helps conserve battery life.
This would also explain why your smartphone’s brightness is reduced in
low-light environments, so it helps to reduce the strain on your eyes.

5. Proximity Sensor: During a call, if the device is brought near your ears, it
automatically locks the screen to prevent unwanted touch commands.

MEMORY IS PRIMARILY OF THREE TYPES

-

1. Cache Memory
2. Primary Memory/Main Memory

3. Secondary Memory

1. Cache‘Memory

Cache memory is a very high speed semiconductor memory which can speed up CPU. It
acts as a buffer between the CPU and main memory. It is used to hold those parts of data
and program which are most frequently used by CPU. The parts of data and programs are

transferred from disk to cache memory by operating system, from where CPU can access

them.

Advantages

%

» Cache memory is faster than main memory.

» It consumes less access time as compared to main memory.

» It stores data for
temporary use.

f)isadvantages

» Cache memory has limited capacity.
» Itis very expensive.

\f

2. Primary Memory (Main Memory):

Primary memory holds only those data and instructions on which computer is curzently
working. It has limited capacity and data is lost when power is switched off. It is
generally made up of semiconductor device. These memories are not as fast as registers.
The data and instruction required to be processed reside in main memory. It is divided
into two subcategories RAM and ROM.

4
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_ Characteristics of Main Memory

» These are semiconductor memories
» Tt is known as main memory.
» Usually volatile memory.

Data is lost in case power is switched off.

v

It is working memory of the computer.

Faster than secondary memories.

. ¥ ¥

A computer cannot run without primary memory.

3. Secondary Memory
This type of memory is also known as external memory or non-volatile. It is slower than
main memory. These are used for storing data/Information permanently Contents of
secondary memories are first transferred to main memory, and then CPU can access it.
For example: disk, CD-ROM, DVD etc.

Characteristic of Secondary Memory

These are magnetic and optical memories

» It is known as backup memory.
» It is non-volatile memory.
> Data is permanently stored even if power is switched off.
» It is used for storage of data in a computer.
COMPUTER PORTS:
Port: It is a physical docking point using which an external device can be connected to the
computer,
Characteristics:

A port has the following characteristics:
% External devices are connected to a computer using cables and ports.

> Ports are slots on the_motherboard into which a cable of external device is plugged in.

» Examples of external devices attached via ports are mouse, keyboard,
monitor, microphone,speakers etc.
" : +« Following are few important types of ports:
UsB .
Serial Port:

» Used for external modems and older computer
mouse

» Two versions : 9 pin, 25 pin model
» Data travels at 115 kilobits per second

Parallel Port
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» Used for scanners and printers

Also called printer port

v

25 pin model

v

PS/2 Port
» Used for old computer keyboard and mouse

“f

Also called mouse port

v

Most of the old computers provide two PS/2 port,
each for mouse and keyboard

Universal Serial Bus (or USB) Port

» [t can connect all kinds of external USB devices such as external hard disk, printer,
scanner, mouse,keyboard etc.
Most of the computers provide two USB ports as minimum.
USB compliant devices can get power from a USB port

VGA Port
» Connects monitor to a computer's video card.
» Similar to serial port connector but serial port connector has pins, it has holes.

» Internal components — CPU, motherboard, RAM etc.
DIGITAL STORAGE BASICS:

"The easiest way to understand digital storage begins with something you know:
digits and the base-10 or decimal number system. Our base-10 number system
likely grew up because we have 10 fingers. A decimal digit is a single place that
can hold numerical values between 0 and 9. Digits are normally combined together
in groups to create larger numbers. For example, the number 6,357 has four digits.
It is understood that in the number 6,357, the 7 is filling the "1s place," while the 5
is filling the 10s place, the 3 is filling the 100s place and the 6 is filling the 1,000s
place. So you could express things this way if you wanted to be explicit.

Name | Abbr. Size
Kilo K 270 = 1,024
Mega| M 2720 = 1,048,576
Giga| G 2730 = 1,073,741,824
Tera T 2740 = 1,099,511,627,776
Peta P 2750 = 1,125,899,906,842,624
Exa E 280 = 1,152,921,504,606,846,976
Zetta | Z 2770 = 1,180,591,620,717,411,303,424
Yotta| Y 2780 = 1,208,925,819,614,629,174,706,176

www.Jntufastupdates.com



~ Storage Devices
“There are many types of devices ‘that can store digital data. Computer disk drives,

CDs, DVDs, Flash drives, iPods etc. all can store some or all of the files types we
have discussed - text files, pictures, programs, music, etc.

Some common examples —

Computer Disk Drive ranging from 20 GB to 400 GB or more, 80
GB is typicalCD ROM disk 650 - 700 MB

DVD ROM disk, single side 4GB

DVD ROM disk, double sided 8GB

Flash drive 128 MB, 256 MB, 512, MB, 1 GB

MP3 Player 1 GB

iPOD nano 2GB, 4GB and 8GB

I
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Installing Operating systefn steps “

I Installing Operating system windows 7

To start Windows 7 from an installation disc or USB flash drive: - I

“ Step 1 Turn on your computer, insert the Windows 7 installation CD-ROM or DVD-ROM drive,
and then re-start your computer.

Il Step 2 T
The computer will boot from the CD-ROM automatically as the BIOS set up, or the massage
of “press any key to boot from CD or DVD” screen will be appear, so Press any key from

" keyboard.

" Step 3 Setup is loading the driver files it needs to continue with installation.
¢ ]

——————————————————————————————————— ————
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Step 4
The first options you will come across are selections for Language, Time and currency format,
‘ and Keyboard language screen will be appear and press the Next button.

Step 5 When the Install Windows page appears, click Install now to begin the installation process.

“ Step 6 Windows 7 is working in the background. This may take several minutes depending on the
system

1y
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Step 7 Next Screen “License Agreement” will be appear. You must accept before continuing.
Check the box next to “I accept the license terms” and select Next button.
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step 9 The next screen will ask you where you want to install the system, meaning on what
partition.

At that point, you need to decide one of the two options:

1- Install Windows on the entire available disk space.

zU
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2 Create @ partition on the hard disk, and install Windows on that partition.
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However we will hose option 2, because we want to create the partition exactly as we want it
Click on“Drive options advanced”. The screen will change and show you these buttons:

New — to create a new partition.

Delete — to delete a speciﬁé partition — all data on that partition will be .
deleted. Format — to format a specific partition — all data on that

partition will be deleted.

Extend — to extend a partition of the limitation of physical disk, and to span the partition on
morethan one physical disk.

Where da you want 1o install WindowsT
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To create a new partition click “New”. In the “Size” box, enter the size for the new partition.

Whendone, click “Apply”.

Note: the size of the partition should be in MB. For example if you want a partition of 24 GB
you willmultiply it by 1024 then write that number in the size box.

24.414x1024= 25,000

wWhere do yoas want 1o instali Windows 7
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To ensune that 2l Aindows Festures wark corvectly, Windows raght create
additional peritions for spstem files.

In most cases, the partition on which Windows will be installed is partition number 2, but you
can also choose where do you want to install OS by selecting that partition. Press “Format” to
format the new partition.

Step 10 Here is where Windows 7 installs major components of the OS. This process
can take 10 to 60minutes depending on the system.

Installing Windows...

That's all the Ffoanation we vend nghi sow, Vous
Lo, S

Step 11 Here we see the system needing to reboot to continue installation tasks
Step 12 Here we see progress as Windows 7 updates the registry settings. This process

may take several minutes before going to the next screen.

Note if you got the message of “press any key to boot from CD or DVD” do not press as it will
boot fromhard disk to continue installation.

—— ——— ——
&0
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Step 13 Windows 7 starts up required services at this point in the setup process.
Step 14 Windows 7 continues to install at this screen. After initial setup is complete,
another reboot is required with no user input. Then setup will prepare the system for initial

Brratatitog WIS ..

[T T P ——_————————— el ]
sttt

booting

1. Enter in your user name and computer name as you would like it to be identified

£7 Windows 7 Ultimate

Chaose a user name for your 3oyt and Rame vour computes to destingunh 4 on the netwaork.

Type a yser name (Tor exsenple, john)
Black Viped

Iype s cornputer Dams

BlackViper- PC

on the network and then select the Next button.
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Set a password for your acoount

Cresting n pastwnred B # TR LEcurty Brecsstion that helps protect yous user aceaunt from
unwanted users, Be nure 1o remember yout passenrd or keeg it in » safe place.
Type & passoord {recommendeds
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Betyps yOur prastword

Type & passward hant {requared)
oy Birt goes hese
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Iywu!mw"ww.ﬂdpm-nﬂm,nuwwm

Type your Windows prochoct key
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s copy of Windowes. The label might 25 NE 6N YSW Compster <a3e. SACTIVSTon Pears Yo
Prodhest ey with Pl COn@es

Tive prodscs key leoks samides to Whis
PRODUCT KEW: XM - RO~ M - MO KRR

iAms ey vl e addnd scAorTaticaty)
by ey e aesise

=5

ARt in asbocdetiunel

Help protect your computer and improve Windows automatically

Uise recommended settings
Wnstall important and recommended updstes, heip make Interme! Siowsing safer, check
onfine for solutions o probiemms, and help Bhcroioft improve Windows. [}

Install important updates only
Only install secatity updates and othes imponant upsdates Tor Windows.

Ask me later
Unitil you decide, your romputer might e vainersbie to security thraats.

wgs of install wpd only, some information i sent to
is ot used 1o identdy you or contact you. To turm off these settings
latee, suareh for ‘Turm off recommended seting in Help snd Support. Baid the privace statement
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4. Ensure that your time zone is entered correetly

Fresvisv yoaar tiove aonck dhate seftnogs

{303 0800 Pacitis Trre (005 S Canssad ..
i Asmoarates ally sposE clos bk fac IPayTighT Seving Tiene

5. Most people will want to use “Home network™ for desktop installations or “Public network”
for aportable system, like a laptop. Make your selection to continue to the next screen

Seabect Yol COMMERUTESN S CUrren® koeabkan

This cormpater s 5 - - e Ay apgh the correct network
Settangs based o e AETwAark s M350,

- Horvie Network
[ e B 4 U caripasters s Phis Natwerk i S5 oo Bosme and yoas secognase T, i i &
Erustm hormme ek, Dol sieese thes tor pubbc Bleces mesd 35 ceffee shops o0
asrgoens.
-3
Work network
# 2l the ¢omputers on this Network are af your workplace, and you recogoize them, this
8 S ed wark netweork, Dend choote s for pulkic phaces such s Leffee Wrops Br
abrpocts.

Public network
E B o don't secoghias ol the commpuises on e oo (fof gasmple youre in a coffes
P shop or sEpet, oF you have mchiie Sreadizand), this 15 & piblic nefesrk and o ned
rrLsTea.

B pou sren t nuce, sedtest Pulied et

6. Finalizing settings, this should only take a few moments to‘complete. Then welcome windows
willappears, after that preparing for your desk top.

.,9 I. - ‘;r-m

Q itk b & ami

Bl <o

B ey bimoes

R, iegina Tout
oF rm

] ﬁ Hurnte Pavsig Cimobathan

R

Bl e
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I Installation o fLinux o
|| Create a Machine in Virtual Box
Step-1) Open Virtual box and click on new button

mmmaﬁmudhwhmmmmmmwn' oty row becmse yin haven't

= > |

mmamammm;mnmhu-nhmmwdm
socated at e s of e wedow.

You can press the F key 10 get nstant Fulp, or wet . v tualbox. org for Tha intest :
nformaton and rews.

Linux and version as Ubuntu 32 bit. And click on next

||

—
—_—
R M

- e
AR AR R

I better. And click on next.

www.Jntufastupdates.com

Step-2) In next window, give the name of your OS which you are installing in virtual box. And select OS like

Step-3) Now Allocate Ram Size To your Virtual OS. I recommended keeping 1024mb (1 GB) ram to run Ubuntu

27




Memory size

Select the amount of memaory (RAM) in megabytes to be allocated to the
wir tual machine.

The recommended memory size is S12 MB.

R S ——————————_— T o poreron FERPRURPR————

S T N e e e e

N R B e e N o O e e P s e B

“4MB

Step-4) Now To run OS in virtual box we have to create virtual hard disk, click on create a virtual hard drive now ||
and click on create button.

The virtual hard disk is where the OS installation ﬁles and data/apphcatlons you create/installing this Ubuntu
machine will reside
r 3

Hard drive

Ifywmshvoucanaddawwhard&wemﬂumm You can
eiﬂ‘:era’eateanewharddﬁveﬂeorselectm&m the list or from another
location using the folder icon.

If you need a more complex storage set-up you can skip this step and make
&mchangestnlhemadmsetthgsmﬂumadineisa’eated

The recommended size of the hard drive is 8.00 GB.

LT

Step-5) select VHD (virtual hard disk) option and click on next

ll
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I
1
|
|
|

Hard drive file type

Please choose the type of file that you would like to use for the new virbsal hacd drive. If
you do Not Nneed to use it with other virtualization software you can leave this setting
urscharsged

i WM%N\%WWW RS A A

Step-6) Click on dynamic allocated and click on next. This means that the size of the disk will increase
dynamically as per requirement

Storage on physical hard drive
Please choose wihe memwdmmmquuusm(m
mw#nmum“mm size {fixed size).

Ammmwmmmnm use space on your physical hard drive as |:
itmw?w.mwm dwuﬂmtmmmmm
space on itis freed. 1

Ammmm&mvmwwmummmmbutbomm

S

SRS

e T S S T

Step-7) Allocate memory to your virtual hard drive .8GB recommended. Click on create button
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S 91 3=
G Create Virtual Hard Drive

File location and size

Please type the name of the new virtual hard drive Sile nto the box below or dick on the
fnldermtosdec:adnffermtfeﬁder to create the file in.

Select the size of the virtual hard drive in megabytes. This size is the limit on the amount of
file data that & virtual machine will be able to store on the hard drive.

B ' & ' ] 5 3 ® .

& ] s ® 2

4.00 MB

UBNTU

So ba Machine (PC) with 8GB Hardisk, 1GB RAM is ready.

How to Install Ubuntu
Step 1) Select the Machine and Click on Start
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snidsy

I : STy
i eperome swm Ubuntu (32 Bt
i | BaseMemory: 102408 UBNTU

Boot Crder: COOND, Hard Disk, Floppy
Acceter atons: rm

| wvideo Memory: 12M8
| Remote Deskiop Servers Dusabled

Conolier: IDE
| IDE Primary Master: CoovD] bt 14 D-desktop-386 o (370.00 B
| Controlier: SATA
i :-A‘mmo. m.mﬂm.a.wm}
{ ai Ao
| Host Driver: mmum
_cmfmler ICH ACS

=

ey T

Ko

| :
{ Step 2) Select the Folder Option
fﬁ Ubntu2 (pmud O} - Oracle VM VirtualBox

J mm.mwuﬂ-u-maﬂwm
m.cﬁz to start your new virtual machine

rl
: o PP “fs@@m.c.,.

i) S L S AR

|

31
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Organize v

i Favortes i i s
B2 Oeshtop & asudio
& Downloads j & Compressed
% RecentPiaces | |k Documents
45 GoogieDrive  |®1 1 IDM Latest 7.1 Full Version Cracked For E...

Foip dplsdes
74300 PM  File folder Select s file
e preview,
204 104 BM File folder
180 Fide

Step 4) Click Start

f{ﬂ UBNTUZ2 [Powered Off] - Oracle VM, VirtualBox

AR T=[ST & 7

Please sslect a virtual optical disk file or a physical optical drive
fontaing a disk to start your new vir tual machine from.

The disk should be suitabie for startng a computer from and shoudd

contan the operating system you wish to nstal on the vrbual machime
if yous want to do that now. The disk be epected from the virbual
drive automabcaly mevér‘:.aalm.d-inoﬂhx

= e O o P a8 | G S mement

2

Step-5) You have an option to Run Ubuntu WITHOUT installing. In this tutorial will install Ubuntu
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- T TR

| Bahass indonesia
Posanski

Catath

Ceftina
Cymsaeg

Dansk

Dasistsch

Eesti

Espanol

E£speranto

Easkara ¢

Francais manmuhwtnﬁﬂm&tmklngswmmmwu computer, directly froem this Chu

Caeiige O if you're ready, you can install Ubundu alongside (or instead of ) your carrent operating systom. This
Galego shouldn't take too long.

parvatski

islenska You may wish to read the reieass Hoin.

For best results, plesse that this computer:
" : of has atleast 6.3 GBavailable drive space
«f s connected to the internet

) pownlosd updates while instailing
Libunty uses thisd-garty saftwaie 1o play Flash, MP3 srwd other medis, and 10 work wilh some graphics and wi-fi hardware. Some of this g
software is propristary. The software is subject to license Lerms inciuded with its documeniation

* pvsbadl this third-party software
Fluards MPS plugss wvcudes MPEG Layer-3 aus decoding taPnology cerned from Fraundoler #% acvd Teehnicohor SA

et =

I Step-7) Seiect option to erase the disk and install Ubuntu and click on install now. This option installs Ubuntu i
into our virtual hard drive which is we made earlier. It will not harm your PC or Windows installation
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by has N fetecied ope

. © Erase disk and install Ubuntu
Weir ering. Thin will dhelete ary Fles on the disk, 7 -
ki

7 Eewrypt tive mewy Ubuntiy instsliation For security
Yo el EHO0SE # Uty ey s the aes sdep.

{7 Use LV with the new Ubuntu instalistion
Thus wedil st w Logical Vol Manegeaiest, § sBowy TG

" Something sise
W Cah ceste of Pesiie paettions yona s, o theote multiple partitions fox Ul

Step-9) Select your keyboard layout, by default English (US) is selected but if you want to change then, you can
select in the list. And click on continue

34
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Charose your kayioerd el

 maglish (Ghana)
| Engbish (Higecia) English (LIS) ~ Charckee
| English (South Africs) English (US) - Englizh (Cotermak)

Engish (LK) 2 ¥ i 8 English (175) - Baglish (Dvorak siternative inker Faticmned ma dead kaoyw)
Ersada s (LI5) (o s B cngush (Us) - English (Dvorak) I ||

! Esperanto 3 English (5] - Englizh (Erearak, international with dead keys)
CEskonian Engiish (LK) - English (rMacintash)

Farcese - Ersgiink (US) - English {Us, alternative inkes nationai)

Filiping e S | i 108 - Erlinhe 110 bntmcoatinant wtth desdbemmd o,

' Ty here Lo test vour kaybosrd

Step-10) Select your username and password for your Ubuntu admin account. This information has been needed
" for installing any software package into Ubuntu and also for login to your OS. Fill up your details and tick on

login automatically to i e login attempt and click on continue
(57 AT (hanion] - Cracie VM Virksuttene : :

“ = ] " vour pame: | shahid ;
; Your computer’s name: | Shahid-Virtual ibox | o
The mame & uwes when & talks to ather (omautas
. : = {‘ i -
. . choose a password: ;“..Q‘-. T v panwans
“ Confirm your password: -...” - .; ’ T il

Oisein : == i
Tt pequire my password to lag in |

7Y Encrypt my home Folder

35
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Linux Operating System commands

The Linux command is a utility of the Linux operating system. All basic and advanced tasks can be done by executing
commands. The commands are executed on the Linux terminal. The terminal is a command-line interface to interact with
the system, which is similar to the command prompt in the Windows OS. C ommands in Linux are case-sensitive.

Linux provides a powerful command-line interface compared to other operating systems such as Windows and MacOS. We
can do basic work and advanced work through its terminal. We can do some basic tasks such as creating a file, deleting a

file, moving a file, and more. In addition, we can also perform advanced tasks such as administrative tasks (including
package installation, user management), networking tasks (ssh connection), security tasks, and many more.

We have divided these commands into following sections so that you can easily identify their usage:

o Linux Directory Commands(pwd, mkdir, rmdir, Is, cd)

o Linux File Commands(touch, cat, rm, cp, mv, paste, vi)

o Linux File Content Commands(head, tail, tac)

o Linux User Commands(su, id, useradd, passwd, groupadd)

o Linux Filter Commands(grep, comm, nl, tr, uniq, wc, sort, gzip, gunzip, tar)

o Linux Utility Commands(find, locate, date, cal, sleep, time, zcat, df, mount, exit, clear)

o Linux Networking Command(ping, ssh, ifconfig, scp, netstat, ipstat, nslookup, traceroute, telnet, host, ftp, arp,

wget,route )

Linux Dire?:tory Commands

1. pwd Command

The pwd ';:ommand is used to display the location of the current working directory.

Syntax: $ pwd ||

2. mkdir Command

The mkdir command is used to create a new directory under any directory. : : ||

Syntax:

mkdir <directory name>

Output:

“> 37
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3. nl command
It is a linux command to number lines of the files,

$nl list.txt

1 apples

2 oranges
3 potatoes
4 lemons

4. rmdir Command
The rmdir command is used to delete a directory.

Syntax:

rmdir <directory name>

Output:

:~$ rmdir new_directory

:~5 i

5. Is Cqmmand

The 1s command is used to display a list of content of a directory.

: " Syntax:

12:25 1s
examples.desktop
hello.c

hello.1
hello.o
hello.s
index.html

Demo. txt~ eclipse 2 ~matl

6. cd Command

The cd command is used to change the current directory.

www.Jntufastupdates.com
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x There are some shortcuts to help you navigate quickly: -

o cd .. (with two dots) to move one directory up

e cd to go straight to the home folder

e cd- (with a hyphen) to move to your previous directory

Syntax:

cd <directory name>

Output:

S c¢d Desktop

s 1l

off s o

lr Linux File commands
1. touch Command

Syntax:

|| touch <file name>
touch <file1> <file2> ....

" QOutput:

»r$ touch Demo.txt
§ touch Demol.txt Demo2.txt

r$ 1s

| 2 catCommand

The cat command is a multi-purpose utility in the Linux system. It can be used to create a file, display
content of the file, copy the content of one file to another file, and more.

Syntax:

|| cat [OPTION]... [FILE]..

The touch command is used to create empty files. We can create multiple empty files by executing it once.

www.Jntufastupdates.com
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To create a file, execute it as follows:

cat > <file name>

// Enter file content

Press "CTRL+ D" keys to save the file. To display the content of the file, execute it as follows:

cat <file name>

Qutput:

S cat » Demo.txt

S cat Demo. txt

3. rm Command

The rm command is used to remove a file.

Syntax:

rm <file name>

Output:

S rm Demo. txt :
rm-Demol.txt Demo2.txt

4. ¢p Command
The cp command is used to copy a file or directory.
Syntax:

To copy in the same directory:

cp <existing file name> <new file name>

To copy in a different directory:

Output:

~$ cp demo.txt demol.txt
~$ cp demo.txt Documents

oint-Inspiron-3
oint-Inspiron-3

.
.
.
.

542
542

40
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" 5. mv Command
The mv command is used to move a file or a directory form one location to another location.

“ Syntax:

mv <file name> <directory path>

Qutput:

3542:~% mv demo.txt Directory

“ 6. paste command

Paste command is one of the useful commands in Unix or Linux operating system. It is used to join files
horizontally (parallel merging) by outputting lines consisting of lines from each file specified, separated
by tab as delimiter, to the standard output. When no file is specified, or put dash (“-*) instead of file
name, paste reads ﬂorq.standard input and gives output as it is until a interrupt command [Ctrl-¢] is given.

Syntax:
|paste [OPTION]... [FILES]...

Let us consider three files having name state, capital and number. state and capital file contains 5 names
of the Indian states and capitals respectively. number file contains 5 numbers. |

$ cat state
Arunachal Pradesh
| Assam

Andhra Pradesh
Bihar
lIChhattisgrah

$ cat capital
Itanagar

|| pispur
Hyderabad
Patna

Raipur

Without any option paste merges the files in parallel. The paste command writes corresponding lines from
the files with tab as a deliminator on the terminal.

||$ paste number state capital
1 Arunachal Pradesh Itanagar
2 Assam Dispur
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3 Andhra Pradesh Hyderabad
4 Bihar Patna
5 Chhattisgrah Raipur

In the above command three files are rherges by paste command.

Linux File Content Commands

1. head Command

The head command is used to display the content of a file. It displays the first 10 lines of a file.

Syntax:

head <file name>

Qutput:

head Demo.txt

2. tail Command

The tail command is similar to the head command. The difference between both commands is that it
displays the last ten lines of the file content. It is useful for reading the error message.

Syntax:

tail <file name>

Output:
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3. tac Command

The tac command is the reverse of cat command, as its name specified. It displays the file content in

reverse order (from the last line).

Syntax:

tac <file name>

Output:

3542:~$ tac Demo.txt

Linux User Commands

1. su Command

l another user.

r Syntax:

The su command provides administrative access to another user. In other words, it allows access of the Linux shell to
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su <user name>

Output:

su javatpoint

2. id Command

The id command is used to display the user ID (UID) and group ID (GID).

Syntax:

:~$ id
javatpoint)

3. useradd Command

'The useradd command is used to add or remove a user on a Linux server.

Syntax:

useradd username
Output:
int@javatpoint-Inspiron-3542:~S sudo useradd JTP

sudo] password for javatpoint:
atpoint-Inspiron-3542:~$ l

4. passwd Command

The passwd command is used to create and change the password for a user.

Syntax:

passwd <username>

int),4(adm),24(cdro
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: Odtp'ﬁ't_: L

:~$ sudo passwd ITP
wWworda:

word:
ated successfully

5. groupadd Command
The groupadd command is used to create a user group.

Syntax:

Linux Filter Commands

groupadd <group name>

Output:

javatpoint@] tpoint-Inspiron- 3542 :~$ iﬁdo groupadd Developer
Lx e 13 i o T - . SE A+ T %
jevVa L L Lild 1d £ il 3 i i Lo A | -

1. grep Command

The grep is the most powerful and used filter in a Linux system. The 'grep' stands for "global regular
expression print." It is useful for searching the content from a file. Generally, it is used with the pipe.

Syntax:

command | grep <searchWord>

Output:

-j;.-sv;}‘%‘::g:ﬂ_;z%:fﬁsj:u;a'f:point-znspimn~5542:~$ cat marks.txt | grep 9

celena-20

2. comm Command

The 'comm' command is used to compare two files or streams. By default, it displays three columns, first
displays non-matching items of the first file, second indicates the non-matching item of the second file,
and the third column displays the matching items of both files.

Syntax:

|
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comm <filel> <file2>

Output:

S comm Demo.txt Demol.txt

3. tr Command

The tr command is used to translate the file content like from lower case to upper case.

Syntax:

command | tr <'old™> <'new"

Output:

ale
alen-70

jon-75
CaRRy-85
Celena-90
jUstin-80 «~

4. uniq Command

The uniq command is used to form a sorted list in which every word will occur only once.

Syntax:

42:~5 cat marks.txt | tr 'prcu’ 'PRCU’

46
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|  command <fileName> | uniq -
Output:

sort marks.txt |unigq

5. wec Command

“ The we command is used to count the lines, words, and characters in a file.

Syntax:

“ wc <file name>

Output:

& we marks.txt

6. sort Command

“ The sort command is used to sort files in alphabetical order.

Syntax:

sort <file name>

" Output:

int-Inspiron-3542:~5 sort marks.txt
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The gzip command is used to truncate the file size. It is a compressing tool. It replaces the original file by
the compressed file having '.gz' extension.

Syntax:

gzip <filel> <file2> <file3>...

Output:

1 marks.t

8. gunzip Command

The gunzip command is used to decompress a file. It is a reverse operation of gzip command.

Syntax:

gunzip <file1> <file2> <file3>. .

Output:

2:~$ gunzip Demo.txt Demol.txt
~§ 1s ; :
examples.desktop
hello.c N s
hello. 1 o new Xk
hello.o . pleo 5

hello.s  Pictures Test.pdf
index.html , ‘ s
matlee .

marks.txt

I 9. A tar.gz file is a combination of a .tar file and a .gz file. It is an archive file with several other
files inside it, which is then compressed.

You can unzip these files the same way you would unzip a regular zipped file:

48
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8 tar ~xvzf documents.tar.gz

@ dejan@ubuntu: ~/Documents

earch Terminal Help
untu: ~foocument<$'ta vz ocuments tar 92 J

- 6¢ :50;1/ gitignore

-rBSS 24/.travis.ynl

P-6855624/LICENSE

eBSSe‘MREQ[‘n\E nd

\SSS 24/camposer. json

624/dec

S824/doc/api. html

024 /geoPHP. inc

4,119[
t/lib/adapters/
4/1ib/adapters/EWKB.class. php
lib;adaptersiﬁwkT class php

L-rP«'\

(=2 Cl
[+~ BNV} (fl

f} L=}

AR
(]
\
d
8

(%0 (7\ 4’,1'

‘KD

}odéf‘tEFSiGEEr’d’}}ter class. php
fadaptersjCecHash.class. php
tb/adapters/GeolsoN.class.php
éfadaptcrtjCe¢PxS '1355 php
leGeocode.class.php
ss.php
5. php
.php

The basic command is tar, followed by four options:
X — instructs tar to extract the files from the zipped file
v — means verbose, or to list out the files it’s extracting

z — instructs tar to decompress the files — without this, you’d have a folder full of compressed files

f — tells tar the filename you want it to work on

Linux Utility Commands
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1. find Command

used to find a particular file within a directory. It also supports various options t0 find a file

The find command is
by date, and more.

such as byname, by type,

The following symbols are used after the find command:

(.) : For current directory name

(/) : For root

Syntax:

j.3‘.:atpoint-znspiron--3.542:«S find . -name "*.pdf”

./Python-3. 5.3/Doc/libgary/turtle-star. pdf

.]ékash/)eomla/@rigional {opy/Broc‘hure-Joomla-ZGlQ.g}df
.f,i.i-:as'njJcaﬁia/Origional Copy/Joomla-Guide—FinaLpdf

9 | .Icca't,’sharejTrash/fiIes/2460966- 258544e72f817db3bcef-1587146240838. pdf
: d982eaaSSch43fb53-1585763626467.pdf

find: '.,i.znydesk/incoming’: permission denied
: j‘Do'.»:n’Loads;CaafimationPage_Zef:}B 9970774 pdf

. Jdemol.pdf

find: “./.dbus’: Permission denied
find: *./.cache/dconf’: Permission denied
. /pirectory/demo.pdf :
./oirectory/demo2.pdf

. /Directory/demol.pdf -

./.localjshare/Trash/files/2460966- 3a

2. locate Command

imilar to find command,; the difference is that it

he find command searches in the file system. It
dated.

The locate command is used to search a file by file name. It is quite s
is a background process. It searches the file in the database, whereas t
is faster than the find command. To find the file with the locates command, keep your database up

Syntax:

locate <file name>

Output:

WAL ! BII ifastund ates-—eem




[javatpoint@javatpoint-Inspiron-3542:~$ locate sysctl.conf
|/etc/sysctl.conf
I/etc/sysctl.d/99-sysctl.conf
f/etc/ufw/sysctl,conf
I/snap/core/8935/etc/sysctl.conf
/snap/core/8935/etc/sysctl.d/99-sysctl.conf
I/snap/core/9066/etc/sysctl.conf
!/snap/core/9066/etc/sysctl.d/99-sysctl.conf
I/snap/core18/1705/etc/sysctl.d/99-sysctl.conf
!/snap/corelS/1754/etc/sysctl.d/99-sysctl.conf
|/usr/share/doc/procps/examples/sysctl.conf
|/usr/share/man/man5/sysctl.conf.5.9z

[}

3. date Command
The date command is used to display date,' time, time zone, and more.

Syntax:

date
Output:

Javatpoint@javatpoint-Inspiron-3542:~$ date
Fri May 22 21:51:05 IST 2020
. L 7 : : - -

Examples: ;' s’

Command:
$date "+%D"
Output?
10/11/17
Command;
$date "+%D %T"
Output:
11 10/11/17 16:13:27
Command:
$date "+%Y-%m-%d"
Output:
2017-10-11
Command:
$date "+%Y/%m/%d"
Output:
2017/10/11
Command:
$date "+%A %B %d %T %y"
Output:
Thursday October 07:54:29 12 17
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4. cal Command

The cal command is used to display the current month's calendar with the current date highlighted.
Syntax:

$ cal [MONTH] [ YEAR]

Output:

javatppint-Inspiroen-3542:~§ cal
20
T

h Fr Sa
.
789
14 15 16
21 M 23 -

28 29 30

$ cal 08 2020

dharam@dharam-H110MHC: ~ .
dharam3dharam-H110MHC:~S$ cal 08 20600
August 2000 :

Su Mo Tu ve Th Fr Sa
1- 2 '3,5.45:5

6 7 8 9 10 11 12
13 14 15 16 17 18 19
20 21 22°23 24 25 26
27 28 29 38 31

cal 2018 : Shows the whole calendar of the year, )
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fI= K

dharam@d haram-H1.1OMHC: =~

dharam@dharan-“lloﬂnc:hs cal 2018

2018
January 2 February
Tu We Th Fr Sa Su Mo Tu We Th We Th
3 4 5 & 1 ) 1
10 11 12 13 q S 6 7 8 7 8
16 17 18 19 26 11 12 13 14 15 14 15
23 23 25 26 27 18 19 20 21 22 21 22
30 31 25 26 27 28 28 29

April May June

Tu We Th Tu We Th Tu We Th

3 4 5 14258 I L

10 11 12 5 & 9 10 S 6 7

17 18 19 3 18 18 17 12 13 14

24 2% 26 22 21 24 < 19 260 21
29 30 31 a4 26 27 28

July August ; september
Tu We Th Tu We Th U Mo Ty We Th
3 4 s 182
10 11 12 T..859% 3 4 5 o6
17 18 19 14 15 16 10 11 12 13
24 25 26 . 21 22 23 p 5 17 18 19 20 2
31 28 29 30 2 24 25 26 27

October November December
Tu We Th Tu We Th Tu We Th
23504 v 1

9 10 11 L4 6 7 8 4 5 &
16 17 18 . 13, 14 15 11 13
23 23 25 26 = 20 21 22 18 19 20
28 31 - 5 27 28 29 2 25 26 27

cal -3 : Shows calendar of previous, current and next month

= dharam@dharam-H110MHC: ~ ot

dharam@dharam-H110MHC:~S cal -3 ! i
November 2018 - December 2018 January 2019 -
Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa
: 17, 3 , 1 12l s as
4 5 '6%%7:.8,-9°10 2 3 4 5 6 7 8 6 7 8 9 10 11 12

11 12 13 14 15 16 17 9 10 11 [ 13 14 15 13.14 15 16 17 18 19
18 19 20 21 22 23 24 16 17-18 19 20 21.22 20 21 .22 23 24 25 26
25 26 27 28 29 30  23/24 25 26 27 2829 27-28 29 30 31

SHE 30 31 iR 3

5. whoami Command: This command reveals the user who is currently logged in.

$whoami

Raghu
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6. clear Command

Linux clear command is used to clear the terminal screen,

Syntax:

$ clear

2:~§ s

examples.desktop tusic Python-3.3.0
hello.c Newfolder sample
hello.i new.txt  snap

composer.phar Document hello.o plco Templates
demol.pdf Downloads hello.s - pictures Test.pdf
eclipse index.html project  Videos
sclipse-installer mail »  public
! eclipse-uorkspace marks.txt Python
javatpoint@javatpoint-Inspiron-3542:~3 izlearl

After pressing the ENTER key, it will clear the términal screen,

7. Help command , _
With almost every command, ‘—help’ option shows usage summary for that command. i
. - ezt \ , e S e -

{ un all [(MMDDhhme[ [CE1YY)[.83]]
£ CUTIIED imps in th= giwen FORMAT, .or set the systsn da

display time degcribed by STRING, nc
like --date once for each'line of
display,. the last modification time of FI
output date and time in RFC 2822 formac,
Exarple: Mon, 07 Aug 2006 12:34:5€ -0680Q

8. Man Command
man command In Linux is used to display the user manual of any command that we can run
on the terminal. It provides a detailed view of the command which includes NAME,
SYNOPSIS, DESCRIPTION, OPTIONS, EXIT STATUS, RETURN VALUES, ERRORS,
FILES, VERSIONS Info '

Syntax : :
$man [OPTION]... [COMMAND NAME]...

$man date
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9. sleep Cbmmnnd
The sleep command is used to hold the terminal by the specified amount of time, By default, it takes time in seconds.

Syntax:

sleep <time>

Output:

@javatpoint-Inspiron-3542:~$ sleep 4

10. time Command

The time command is used to display the time to execute a command.

542:~S time

real OMmG .606S

user .6mD.G0GSs
fHsys OmO.060s

11. zcat Command
The zcat command is used to display the compressed files,

Syntax:

zcat <file name>

Output:
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jawp tR javatpoint—lnsptrondsqz =S s

3 pgemo.txt.gz examples.desktop Music python-3.8.0
Akash pesktop hello.c Newfaolder sample

Directory hello.i new. txt snap
Documents hello.o pilco Templates
pownloads hello.s pictures Test.pdf
eclipse index.html project Videos
eclipse-installer matl Public
Demo. txt-~ eclipse-workspace marks.txt python
javatpointgjavatpoint-Insptron—3542:~$ zcat Demo.txt

12. df Command

The df command is used to display the disk space used in the file system, It displays the output as in the number of
used blocks, available blocks, and the mounted directory.

; g
Output: {

—————

javet;:o'mtﬁijavatpoint-lnspiren_—354?.:~$ df. : :
Filesysten 1€-blocks  Used Available Use% Mounted on
1931652 .0 1931652 0% /dev
393260 - 1756 391504 © 1% /run
479668904 26471148 428762148 - 0% / ;
1966284 ' 243536 1722748 13% /dev/shm. .
5120 - 4 5116 " 1% /run/lock’
1966284 0 1966284 0% /sys/fs/cgroup

231936 231936 .0.100% /snap/wine:platforn-runtine/136
Jdev/loop2 144128 144128° D 100% /snap/gnome-3-26-1604/98
[dev/loopd 384 384 0 100% /snap/gnome-characters/539
/dev/[loop6 . 220160 220160 0 100% [snap/wine:platforn:5-stable/4
[dev/loop5 164096 © 164096 ° - 0 100% /snap/gnome=3-28-1804/116 .

13. mount Command

The mount command is used to connect an external device file system to the system's file system.

Syntax:

www.Jntufastupdates.com
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"mount -t Fyij_g <device> <qireét6ry>' ‘

javatpointajauatpotnt;lnspiron-3542:~$ mount
sysfs on [sys type sysfs (rw,nosuid,nodev,noexec,relattme)

proc on /proc type proc (rw,nosuid,nodev,noexec,relattme)
udev on /dev type devtmpfs (rw,nosuid,relatime,size=1931652k,nr_inodes=482913,mo

de=755)
devpts on /dev/pts type devpts
e=000)
tmpfs on frun type tmpfs (rw,nosuid,
Jdev/sdal on [ type ext4d (rw,relatime,error
securityfs on /sys/kernel/security type securityfs

ime)
tmpfs on /dev/shm type tmpfs (rw,nosuid,nodev)

(rw,nosutd,noexec,relattme,gidzs,mode:ﬁzo,ptmxmod

noexec,relatime,size=393260k,mode=755)

s=remount-ro)
(rw,nosuid,nodev,noexec,relat

14. exit Command
Linux exit command is used to exit from the current shell, It takes a parameter as a number and exits the shell with a

return of status number.

Syntax:

-Inspiran-BSdzéfs exitl i

jav;;‘-:;:-oint'::j::vat—gzstnt

After pressing the ENTER key, it will exit the terminal.

Linux Networking Commands

> ping
The ping command sends an echo request to a host available on t
if your remote host is responding well or not.

The ping command is useful for the following:
O Tracking and isolating hardware and software problems.
O Determining the status of the network and various foreign hosts.

he network. Using this command you can check
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0 Testing, measuring, and managing networks,

Syntax:
Following is the simple syntax to use ping command:
$ping hostname or ip-address

The above command starts printing a response after every second. To come out of the command, you can
terminate it by pressing CNTRL + C keys.

Example

Following is an example to check the availability of a host available on the network —
$ping google.com

PING google.com (74.125.67.100) 56(84) bytes of data,

64 bytes from 74.125.67.100: icmp_seq=1 ttl=54 time=39.4 ms

64 bytes from 74.125.67.100: icmp_seq=2 ttl=54 time=39.9 ms

64 bytes from 74.125.67.100: icmp_seq=3 (tI=54 time=39.3 ms

64 bytes from 74.125.67.100: icmp_seq=4 1t1=54 time=39.1 ms

64 bytes from 74.125.67.100: icmp_seq=5 (tl=54 time=38.8 ms

--- google.com ping statistics ---

22 packets transmitted, 22 received, 0% packet loss, time 21017ms
rtt min/avg/max/mdev = 38.867/39.334/39.900/0.396 ms

3

If a host does not exist, you will receive the following output —

------
-----

|
Ll ¢
$ {

i

| r -"
> ftp ' ‘
Here, ftp stands for File Transfer Protocol. This utility helps you upload and download your file from one

computer to another computer. The fip utility has its own set of Unix-like commands. These commands help you
perform tasks such as —

O Connect and login to a remote host.

O Navigate directories.

O List directory contents,

O Put and get files.

O Transfer files as ascil, ebedic or binary.

Syntax
Following is the simple syntax to use the ping command -
|| $ftp hostname or ip-address :

The above command would prompt you for the login ID and the password. Once you are authenticated,
you can access the home directory of the login account and you would be able to perform various commands.
Example
Following is the example to show the working of a few commands —
$ftp amrood.com
Connected to amrood.com,

220 amrood.com FTP server (Ver 4.9 Thu Sep 2 20:35:07 CDT 2009)
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|»

Name (amrood com; amrood) amrood b, v AT
331 Password required for amrood.
Password:
230 User amrood logged in.
ftp> dir
200 PORT command successful.
150 Opening data connection for /bin/ls,
total 1464
drwxr-sr-x 3 amrood group 1024 Mar 11 20:04 Mail
drwxr-sr-x 2 amrood group 1536 Mar 3 18:07 Misc
drwxr-sr-x 5 amrood group 512 Dec 7 10:59 OldStuff
drwxr-sr-x 2 amrood group 1024 Mar 11 15:24 bin
drwxr-sr-x 5 amrood group 3072 Mar 13 16:10 mpl
-rw-r--r-- 1 amrood group 209671 Mar 15 10:57 myfile.out
drwxr-sr-x 3 amrood group 512 Jan 5 13:32 public

> telnet

There are times when we are required to connect to a remote Unix machine and work on that machine remotely.

Telnet is a utility that allows a computer user at one site to make a connection, login and then conduct work on a
computer at another site.

Once you login using Telnet, you can perform all the activities on your remotely connected
machine. The following is an example of Telnet session —

C:>telnet amrood. com

Trying... N ‘ ; ]
Connected to amrood.com. ! f {
Escape character is "\]'

login: amrood

amrood's Password:

tttttt#ttit#*###tt#,t**#*t****************‘****ﬁ*****
* %

“

* WELCOME TO AMROOD,COM *
* *

- *

o s 2 o o 2 e 190 o o ok oo o oo o ok o o oo e o ok ke ol ol ke ok e o o e e ol ke e o ol ke o ol e o o o o o o e ok

Last unsuccessful login: Fri Mar 3 12:01:09 IST 2009
Last login: Wed Mar 8 18:33:27 IST 2009 on pts/10

{ do your work }

$ logout

Connection closed,

C:>

» ssh

SH client utility in unix or linux server is used to logging into a remote host and execute commands on the remote
machine. The rlogin and rsh commands can also be used to login into the remote machine. However these are not
secure. The ssh command provides a secure connection between two hosts over a insecure network
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1. Logging to a remote server - &
You can login to a remote server from the local host as shown below:

localhost: [~]> ssh -1 username remote-server

username@remote-server password:

remote-server: [~]>

Alternatively you can use the below ssh command for connecting to remote host:

localhost: [~]> ssh username@remote-server
username@remote-server passwdrd:

remote-server: [~]>

> ifconfig

ifconfig stands for "interface configuration.” It is used to view and change the configuration of the
network interfaces on your system.

Running the ifconfig command with no arguments, ’iike this: ‘.

ifconfig

{

i { i
i 1] i

...displays information about all network interfaces currently in operation. The output will resemble the

following:

ethO Link encap:Ethernet HWaddr 09:00:12:90:e3:e5
inet addr:192.168.1.29 Becast:192.168.1.255 Mask:255.255.255.0
inet6é addr: fe80::a00:27ff:£e70:e3£5/64 Scope:Link -
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1l

~ RX packets:54071 errors:1l dropped:0 overruns:0 frame:0

TX packets:48515 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:22009423 (20.9 MiB) TX bytes:25690847 (24.5 MiB)
Interrupt:10 Base address:0xd020 :

lo Link encap:Llocal Loopback
inet addr:127.0.0.1 Mask:255.0.0.0

UP LOOPBACK RUNNING MTU:16436 Metric:l

inet6é addr: ::1/128 Scope:Host .
RX packets:83 errors:0 dropped:0 overruns:0 frame:0 (
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SRS TX .packets:B83 errors:0 dropped:0_overruns:0 carrier:0 |
T4.-00 7 Collisions:O”txqueuelen: O e e g
RX bytes:7766 (7.5 KiB) TX bytes:7766 (7.5 KiB)
wlan0 Link encap:Ethernet HWaddr 58:a2:c2:93:27:36
inet addr:192.168.1.64
Boast:102.168.2.255 Mask:255.255.255.0
inet6 addr: feBO::6aa3:c4ff:£fe93:4746/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1l
RX packets:436968 errors:0 dropped:0 overruns:0 frame:0
TX packets:364103 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:115886055 (110.5 MiB) TX bytes:83286188 (79.4 MiB)

Here, eth0, lo and wlan0 are the names of the active network interfaces on the system.

eeth0 is the first Ethernet interface. (Additional Ethernet interfaces would be named ethl, eth2, etc.) This
type of interface is usually a NIC connected to the network by a category 5 cable.

«lo is the loopback interface. This is a special network interface that the system uses to ¢

ommunicate with
itself.

ewlan0 is the name of the first wireless network interface on the system. Additional wireless interfaces
would be named wlanl, wlan2, etc. :

> scp

SCP (secure copy) is a command-line utility that allows you to securely copy files and directories between two
locations. i : ~f e -

]
| 3 f ;" !

With scp, you can copy a file or directory:

» From your local sjrstcm to a remote system. ;
« From aremote system to your local system, '
« Between two remote systems from your local system.

When transferring data with scp, both the files and password are encrypted, so thnt'anyonc s

nooping on the traffic
doesn’t get anything sensitive.

Copy a Local File to a Remote System with the scp Command-
To copy a file from a local to a remote system run the following command:

$ scp file.txt remote_username@10.1 0.0.2:/remot<':/directory

Where, file.txt is the name of the file we want to copy, remote_username is the user on the remote
server, 10.10. 0.2 is the server IP address, The /remote/directory is the path to the directory you want to
copy the file to, If you don't specify a remote directory, the file will be copied to the remote user home directory.

You will be prompted to enter the user password, and the transfer process will start.
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Output:
remote username@10.10.0.2's password:
file.txt : 100% 0 0.0KB/s  00:00

# netstat

interface) and network protocol statistics.

performance measurement.

List All Ports (both listening and non listening ports)

List all ports using netstat -a

# netstat -a | more

Active Internet connections (servers and established) .

Proto Recv-Q Send-Q Local Address - Foreign Address State
tep B @ localhost:36037 wo ‘ © LISTEN
udp @ [ 8 *:bootpc [ xx -

f B i _ oy ’ ,r _
Active UNIX domain sockets (servers and established)

Proto RefCnt Flags Type State I-Node Path
unix 2 [ ACC ] STREAM LISTENING 6135 /tmp/.X11-unix/X0
unix 2 [ ACC ] - STREAM LISTENING 5140 fvar/run/acpid.socket

List all tcp ports using netstat -at

# netstat -at

Active Internet connections (servers and established)

|| Proto Recv-Q Send-Q Local Address ~ Foreign Address State

L

netstat ("network statistics") is a command-line tool that displays network connections (both incoming and
outgoing), routing tables, and many network interface (network interface controller or software-defined network

It is used for finding problems in the network and to determine the amount of traffic on the network as a

A A A P T TN ki
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Yepe T3 S5 pelotalhost: 30037 R SR T INL IIISIISTENS e T SR

tcp ) 8 localhost:ipp _ ¥ LISTEN
tcp 9 @ *:smtp ¥ LISTEN

tcpé %} 0 localhost:ipp [::]:* LISTEN

List all udp ports using netstat -au

# netstat -au

Active Internet connections (servers and established)

B

Proto Recv-Q Send-Q Local Address Foreign Address - .St_ate
udp ] @ *:bootpc ' = o4
udp 2] B *:49119 : i
udp 2] @ *:mdns * ok
> ipstat

ipstat command to report statistics about IP traffic. ipstat prowdes options to gather and report statistics only
on IP traffic matching specified source or destination address, interface, and higher layer protocol. For more
information, refer to the ipstat man page.

To gather and report statistics on IP traffic based on the selected output mode and sort order, use the “ipstat -1”
with command.

Example 1 Reporting the Five Most Active IP Traffic Flows
The following command reports the five most active IP traffic flows.

# ipstat -15

SOURCE DEST PROTO IFNAME BYTES
adc-twvpn-2.oraclevpn.com duff,cs.uni.edu [0]0) net0 6.6K
inet-bip2v-10.oracle,com bud,bang,uni.edu TCP tun0 6.1K
duff.cs,uni.edu adc-twvpn-2,oraclevpn.com UDP net0 964.0
bud.bang.uni.edu inet-bip2v-10.oracle.com TCP tun0 563.0
coors.foo.uni.edu 255,255,255,255 upp net0 66,0

Total: bytes in: 12,6K bytes out: 2.2K

Example 2 Displaying a Timestamp

The following command reports the top IP traffic with a timestamp in standard date format. New reports are
63
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 printed below previous reports, and the interval is set to ten seconds,
# ipstat -d d -¢ 10
Monday, March 26, 2012 08:34:07 PM EDT

SOURCE DEST ' PROTO IFNAME BYTES
adc-twvpn-2.oraclevpn.com duff.cs.uni.edu upp net0 15.1K
inet-bip2v-10,oracle.com bud.bang.uni.edu TCP tuno 13.9K.
duff.cs.uni.edu adc-twvpn-2.oraclevpn.com UDP net0 2.4K
bud.bang.uni.edu inet-bip2v-10.oracle.com  TCP tun0 1.5K
coors.foo.uni.edu 255.255.,255.255 ~ uDpP net0 66.0
bigip-stbeehive-adc.oracle bud.bang,uni.edu 5 TCP tun0 29.0

bud.bang.uni.edu bigip-stbeehive-adc. oracle TCP tuno 20.0

Total: bytes in: 29.1K bytes out: 3.8K

> nslookup
nslookup (name server lookup) is a tool used to perform DNS lookups in Linux. It is used to display DNS

details, such as the IP address of a particular computer,

For example, to display the IP address of a hostname, use the following qommand:

- nslookup linux-bible.com
192.168.198.2
- 192.168.158.2#53

MNon- authoritative answer:
MNamz: linux-bible.com
Address: 198.57.241.163

To do a reverse DNS lookup, use the followm
nslookup 203.117.229.183
192.163.193.2
192.1€8, 198, 2#53

Non-authoritative answer.: j .
183.229.117.2028.1n-addr.arpa name = cache.google.com.

Authoritative answers. can be found from:

> traceroute
The traceroute command prints the route that packets take to a network host.
The Internet is a iarge and complex aggregation of network hardware, connected together by gateways.
Tracking the route your packets follow (or finding a gateway that's discarding your packets) can be
difficult. The traceroute command utilizes the IP protoco] "time to live" field and. attempts to elicit
\ an JCMP TIME_EXCEEDED response from each gateway along the path to some host.

Example

$traceroute computerhope.com

H
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Trace the route that-'p'ac:_l’{telts“take between yoiir.fsyﬁtgln and the host named compﬁte-rliope.com, using the default

method (udp datagram, 16 simultancous ﬁrobés). The results will look similar to the following output:

traceroute to computefhope.com(166.70.10.23), 30 hops max, 60 byte packets

1 176.221.87.1 (176.221.87.1) 1.474 ms 1.444 ms 1.390 ms

2 f126.broadband2.quicknet.se (92.43.37.126) 10.047 ms 19.868 ms 23.156 ms

3 10.5.12.1 (10.5.12.1) 24.098 ms 24.340 ms 25.311 ms

4 212.247.178.9 (212.247.178.9) 25.777 ms 27.184 ms 27.625 ms

5 _vst—ncore—l.bundle—etherl.tele2.net (130.244.39.46) 30.632 ms 31.610 ms
32.194 ms

6 kst5—core—l.bundle—etherG.telez.net (130.244.71.178) 33.608 ms 15.274 ms
16.449 ms

7 kstS—peer—l.an-unitO.teleZ.net (130.244.205.125) 252.53 ms 11.169 ms 12.158 ms
8 avk6—peer—1.an—unitO.teleZ.net (130.244.64.71) 19.661 ms 25.765 ms 26.730
ns

9 peer—a33257.avk6.tele2fnet (130.244.200.106): 25.390 ms 24.863 ms %xe-5-0-
0.nyc30.ip4.tinet.net (89.149.181.109) 23.626 ms

10 fortress—-gw.ip4.tinet.net (216.221.158.90) 29.943 ms 31.112 ms 29.002 ms
11 208.116.63.254 (208.116.63.254) 32.102 ms 29.862 ms 29.337 ms

> host

host performs DNS lookups, converting domain names to IP addresses and vice versa. When no arguments or
options are given, host prints a short summary of its command line arguments and options.

EXAMPLE-1:

Making simple query for any siteli say google.com using site; name I
' I i f

$ host google.com

output:

google.com has address 172.217.26.174 f
google.com has IPv6 address 2404:6800:4007:801::200e
google.com mail is handled by 20 alt1 .aspmx.l.google.com.
google.com mail is handled by 30 alt2.aspmx.l.google.com.
google.com mail is handled by 40 alt3.aspmx.l.google.com.
google.com mail is handled by 10 aspmx.l.google.com.
google.com mall is handled by 50 alt4.aspmx.l.google.com.

EXAMPLE-2:

$host 204.228.150.3

This command performs a reverse lookup on the IP address 204.228.150.3,
which results in the output: '
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3.150.228. 204, iri"—'avddjr ..ai:pa' domdin name pointer-

www . computerhope.com.

> arp

The arp command manipulates or displays the kemel's IPv4 network neighbour cache. It can add entries to

the table, delete one, or display the current content.

ARP stands for Address Resolution Protocol, which is used to find the address of a network neighbor for a

given IPv4 address.

Arp is part of the net-tools package. For example, on systems that use APT for package management, it

can be installed with apt-get:

sudo apt-get update && sudo apt-get install net-tools

Example 1: Display entries

Invoking the arp command without any options will display the contents of the arp cache table.

[root@linixnix ~]# arp Y

I
Sl TR NERL
-~

Address ' HWtype HWaddress__:! Flags Mask lﬁce_ A i
192.157.175.1 ether 00:50:55:¢0:00:07 C eth0
192.157.125.2 ~ ether oe:so:ss:ra:gz:xa €A cthd j
192.157.175.254 ether 00:50:55:e5:7d:12 C : cth0 '
[root@linuxnix ~]# Meo! gats

Example 2: Display entrics for particular addresses. . o

If we have a large arp cache and need to get entries for a particular IP address then we could do so by using the-

arp command with the -a optién followed by the IP address. Given below is an example:

[ssuri@iinuxnix-phy:~] $ arp -a 159.254,171.22
? (159.254,171,22) at f7:bd:75:ac:dd:7a [ether] on bond0
? (159.254.171.22) at £7:bd:75:ac:dd:7a [ether] on bond1

> wget
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“wget command is a'Lif{LLk-cointn;iﬁd line utility that helps us to download the files from the web, We can,
download tlic files from web servers using HTTP, HTTPS and FTP protocols. L

The simplest way to use wget is to provide it with the location of a file to download over HTTP. For example, to
download the file http:Ilwcbsite.comlﬁleslﬁlc.zip,’ this command:

|

wget http://website.com/files/file.zip

_..would download the file into the working directory.

There are many options that allow you to use wget in different ways, for different purposes. These are outlined

below.

- » route
In computer networking, arouter is a device ~responsible
When datagrams arrive at a router, the router must determine the best way

The route command displays or modifies the IP routing table.

for forwarding network traffic.
to route them to their destination.

Running route at the command line without ahy options displays the routing table entries:

route

g | Il ‘

! ! | ) |
Kernel IP routing table ' ‘
Destination Gateway . Genmask Flags Metric Ref Use Iface
default 192.168.1.2 0.0.0.0 uG 1024 O 0 ethO
192.168.1.0 * ' 255,255.255.0 U 0 0 0 ethO

y conﬁgurfcd. If a packet comes into the system and has a

" This shows us how the éystcm is currentl
8.1.255, then it is forwarded to the gateway *, which

destination in the range 192.168.1.0 through 192.16
is 0.0.0.0— a special address which represents an invalid or non-existant destination. So, in this case, our system

will not route these packets.

If the destination is not in this IP address range, it is forwarded to the default gateway (in this

case, 192.168.1.2, and that system will determine how to forward'the traffic on to the next step towards its

destination.
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MICROSOFT OFFICE WORD & MICROSOFT POWER POINT

Microsoft Office Word 2010 allows you to create and edit personal and business documents, such as
letters, reports, invoices, emails and books.

By default, documents saved in Word 2010 are saved with the .docx extension. Microsoft Word can be
used for the following purposes:

To create business documents having various graphics including pictures, charts, and diagrams.
To store and reuse ready-made content and formatted elements such as cover pages and sidebars.
To create letters and letterheads for personal and business purpose.

To design different documents such as resumes or invitation cards etc.

To create a range of correspondence from a simple office memo to legal copies and reference

YV V V V¥V

v

documents.

GETTING STARTED WORD 2010
To start a word 2010 applic‘éition in simple steps. Assuming you has Microsoft Office 2010 installed in
your PC, to start word application, follow the following steps at your PC:

Step (1): Click Start button!

Step (2): Click All Programs option from the menu.
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Iicraamtt Word 2010

This will launch Micms?ﬂ Word 2010 application and you will see the following word-\:vindow.

T T S e, U enite o ey 5 r

| P

V.,u_
—

EXPLORE WINDOW IN WORD 2010

Following is the basic window which you get when you start word application. Let us understand various
important parts of this window.
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File Tab:
The File tab replaces the Office button from Word 2007. You can click it to check backstage view, which

is the place to come when you need to open or save files, create new documents, print a document, and do

other file-related operations.

Quick Access Toolbar:
This you will find just above the File tab and its purpose is to provide a convenient resting place for the

Word most frequently used commands. You can customize this toolbar based on your comfort.

/ t
Ribbon: ~ ! |
LI VTR R T 3T e R e

Home] 1nsert Pagel.aynut Rererrncu Mailmqs ‘Reéview \rtw Add-Ins & e

[ﬂ 4 'Calibri Body) “ i '.'i| == eha IR uéa %j
4 _M v | *E, / } \
Paste s (12 {b - ih % % J E AN ,,_' v= ] Styles Edttin@ !
e T AT A A A A PR R I | [ * 5
'Gipboaud ra Fonl a Faragraph G ! '

Ribbon contains commands organized in three components:
> Tabs: They appear across the top of the Ribbon and contain groups of related commands. Homes,

Insert, Page Layout are example of rxbbon tabs.
> Groups: They organize related commundS' each group name appears below the group on the R]bbon
For example group of commands related to fonts or or group of commands related to alignment etc.

» Commands: Commands appear within each group as mentioned above.

Title bar:
This lies in the middle and at the top or the window. Title bar shows the program and document titles.
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Rulers:

Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler appears just beneath the

Ribbon and is used to set margins and tab stops. The vertical ruler appears on the left edge of the Word

window and is used to gauge the vertical position of elements on the page.

Help:
The Help Icon can be used to get word related help anytime you like. This provides nice tutorial on

various subjects related to word.

Zoom Control: Zoom control lets you zoom in for a closer look at your text. The. zoom control consists
of a slider that you can slide left or right to zoom in or out, . and + buttons you can click to increase or
decrease the zoom factor.

View Buttons'

The group of five buttons located to the left of the Zoom control, near the bottom of the screen, lets you

switch among Word's various document views.

Print Layout view: This displays pages exactly as they will appear when printed,

Full Screen Readu]g view: This gives a full screen, 'look of the document. ,

Web Layout view: This shows how a document appcars when viewed by a Web browscr such as Internet
Explorer.

} i
/ f

Outline view: This lets you work with outlines established using Word's standard heading étyles.

Draft view: This formats text as it appears on the printed page with a few exceptions. For example,
" headers and footers aren't shown. Most people prefer this mode,

Document Area:

The area where you type. The flashing vertical bar is called the insertion point and it represents the
location where text will appear when you type,

Status Bar:

This displays document information as well as the insertion point location. From left to right, this bar

contains the tota} number of pages and words in the document, language etc.

You can configure the status bar by right-clicking anywhere on it and b

y selecting or deselecting options
from the provided list,
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Dialog Box Launcher:

This appears as very small arrow in the lower-right corner of many groups on the Ribbon. Clicking this
button opens a dialog box or task pane that provides more options about the group.

SAVE DOCUMENT IN WORD 2010

SavingNew Document:

Once you are done with typing in your new word document, it is time to save your document to avoid
losing work you have done on a Word document. Following are the steps to save an edited word
document:

Step (1): Click the File tab and select Save As option.

I'tl-l smin Saym As
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Step (2): Select a folder where you would hke to save the document, Enter file name which you want to -

give to your documcnt and Select a Save as type, by default it is .docx format

Folder to save the d——um-ﬂt

]
Lsiudag: 2 & poiniiped Arvarige Ry *elter =

£ M
[0 [ PP = Docurmeants library
ds Ternpistes I8
k ot Bg TR it Piafiah Dalaiin ~da Ny PAP
v Ly | ‘]
""‘“n B Bt RS v inrtn el e oacty S Aty Shapad
-b D"'n Ldoh ArmBeoid s Fouys A Py e
- N »' ’ i Aprasne Mudis ¥ Warks pece it Vavpte Tell Resrives Fites o Paacal I
ey Mee -~ s AP ol 1enaDIVD e Bk el o
e L Bhnteeih Erchangs Foluar WESN. Ad Eofarvee
e Sentag -4 isTeeai b st stalll
-
-;.::..:.'... i CpP Rote_cdelear et SHa i My Carel Lnaws . Wyrense :
-~ L D o e Cymartenk ki By DA Da vervis dade wd bermpretas i
-l

LY W - e a ", ]
Fue parey | tt-u..q-‘- e :

Sove ov srve (WP By e {2 dmee)
Sl sarm

Vauss hstit m ven
)2 hva Thuekned

(Hiasim Fodsbarp Tamis = QSE" Iw-M -Z-‘I:;—‘_“‘j

relder Names Plile Name Dasumans Tyea

0

Step (3): Finally, click on save button and your document will be saved with the entered name in the
selected folder,
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Saving New Changes:
y be a situation when you open an existing document a
een cditing of the document. If you wa

nd edit it partially or complelely, or even

There ma
nt to save this document

you would like to save the changes in betw

with the same name then you can use cither of the following simple options:

» Just press Ctrl + S keys to save the changes.

» You can also use third method to save the changes, which is save option available just above the Save

As option as shown in the above screen capture.
» If your document is new and it was never saved so far, then with any of the three options, word would
display you a dialogue box to let you select a folder, and enter document name as explained in case of
saving new document.

OPEN DOCUMENT IN WORD 2010

oenineExisineD
There may be a situation when you ©
want to open an existing document then follow the iollowing simple options:

pen an existing document and edit it partially or completely. If you

Step (1): Click the File tab and select Open option.
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Step (2): This will display following file Open dialog box, which lets you navigate through different file

folders and also lets you select a file which you want to open.
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Step (3): Finally locate and select a file which you want to open and click small triangle available

on Open button to open the file. You will have different options to open the file, but simply
use Open option,

FORMATTING TABS

Setting Text Fonts and Size in Word 2010
Microsoft word allows you to use different fonts with different size. You can change your document's
appearance by changing the fonts and their size. Usually you use different fonts for paragraphs and
hcadin@. So it is important to learn ho,\?r to use different fonts,

i

1) CHANGE THE FONT TYPE & SIZE: I\ ;

Let me give a brief idea about font buttons which we are going to use in this tutorial. Here is a screen .

capture to show you few font related buttons.
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You can assiy change tha formatting of selected textinthe
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Step (1): Select the text that you want to change to a dlffcrcnt font and click Home tab. Now click Font
Type button to list down all the fonts available as shown below.
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Step (2): Try to move mouse pointer over different fonts listed. You will see that text font changes when

you move mouse pointer over different fonts. You can use Font Scroll Bar to display more fonts

available, i’ina]ly select a desired font Ey!clicking over the font name in the list. I selected MV Boli for

my sample text.
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Stcp (3): Similar way, to changc the font size, chck over the Font SIZC button whlch w111 display a font

size list.'You will use same procedure to select a desired font size whai you have used while selecting a

font type.
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10

Use Shrink and Grow Buttons: .
You can use a quick way to reduce or enlarge the font size. As shown in first screen capture, Shrink

Font button can be used to reduce the font size whereas Grow Font button can be used to enlarge font

S1Z€.
Font Grow Whitton
Fopt Shilnk Button

-y 5¥{.,£. ¥ e nﬂuum-ni MMWW‘:'—‘J@W
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diagrams, thay ska coardinate wih your cucant dotuman

¥ou cam aslly change the formarting of selactad text i the
Inck {or the splected texy fram the Quick Styles gallery onil
tent directly by using the pihar controks on the Home fab. &
using tha kook Fromthe current thirms er using 0 format the

Try to click either of these two buttons and you w111 see the effect. You can click a single button multiple

times to apply the effect. Each time you click either of the buttons; it will enlarge or reduce the font size

by 1 point.

2) Text Decoration in Word 2010

i : l This chapter will teach you how to decorate your
text in Mlcrosoft word 2010. When I'm saying
decorate, it means decorate by making it in italic
shape, uf,ndcrlining the text or making 1t bold to
look more fancy. Finally we will see how we can

E 23 B
. | Quick Clunu M“M
1L RO | Sytesv !Mﬁ *

strikethrough a text.
Making text bold: A bold text appears with

'%; heavy weight and dark ink and we use bold text

|
|
|
s -H.’I‘
A

lim, cover pun. M other urwnt building blocks, When you eraste pictures,

diagrams, they also coordinate with your current document look, to give more emphasis on the sentence. This is

v
You can easly changs the formatting of selected text In the document text by choot * | very si n :
look for the salected text from the Quick Stylas gallery on the Homa ub You un il i ery lmple to cha ge selectcd text into bold font

H_ | by following two simple steps:

Step (1): Select the text that you want to change to a bold font. You can use any of the text selection
method to select the text,

Step (2): Click Font Bold [B] button in the Home tab Font group, or simply use Ctrl + B keys to make
selected text bold,

77

|

|

www.Jntufastupdates.com
Scanned with CamScanner
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Step (1): Select the text that you want to change

to a bold font. You can use any of the text

selection method to select the text.
Step (2): Click Font Italic / I ] button in the Home tab Font group, or simply use Ctrl + I keys to convert
text in italic font.

Underline the Text:
An underlined text appears with an underline

and we use underlined text to make it more
distinguished from other text. This is very
simple to change selected text into underlined
font by following two simple steps: ‘
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Step (1): Select the text that you want to change {i Yo com easiipcharigh thi formatting of selected text n the: ducumest text by chon )
to a bold font. You can use a.ny of the text : kzd:farthlﬁlectedtmirom‘hemick&y!ﬂganﬂymﬂnHomclab.\’mua-l:
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selection method to select the text. ' Ce1 e L‘:ﬁ BRI IEI AN i OO O

Step (2): Click Font Underline [ U ] buuon_ in the Home tab Font group, or simply use Ctrl + U keys to
put an underline under the text.

Strikethrough the Text:

Strikethrough text will look like a line has been drawn
through its‘middle. A strikethrough text indicates that it
has been deleted and not any more required. This is very

“"m""""'—i“'luﬂ-l\hwmmm:

Gagrama, Oy oo coordmms i Yo carret oraemers loch ] simple to change selected text into strikethrough font by
t-m-qmunumdmunhm—nm'
ubnu.uu-b—n-mtﬁ-m-nnwulu.ma:

—

following two simple steps:
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. Step (1) Select thc; text that you want to change to a bold font. You can use any of the text selection

method to select the text.

Step (2): Click Font Strikethrough f-abe} button in the Home tab Font group to put a line in the middle of

the text which is called strikethrough the text.

3) CHANGE TEXT CASES IN WORD 2010

This chapter will teach you how to change cases of your text in Microsoft word 2010. You can also
capitalize a character you are typing by pressing and holding SHIFT while you type. You can also press
CAPS LOCK to have every letter that you type be capitalized, and then press CAPS LOCK again to turn

off capitalization.

HOme tab Change Une Oplions

Change Text to Sentence Case:

A sentence case is the case where first character

of every sentence is capitalized: This is very

simple to change selected text into sentence case

by following two simple steps:

e — e g Step (1) Select the text that you wm:t to change
Tkt Sy verted et o e itk s lary em e 2l 10 a bold font. You can use any of the text

selection method to select the text.

Step (2): Click the Change{ Case button and then select rScntcncc Case option to capit;\lize the first
character of every selected sentence.

Change Text to Lowercase:

A lowercase: is the case where every word
of a sentence is in lowercase. This is very
simple to change selected text into

lowercase by following two simple steps:

Step (1): Select the text that you want to
change to a bold font. You can use any of

toat b Py s
-y -y l-ldulcl.ulrn n muu ld";m':'-n

the text selection method to select the text.

ﬁ_— wananas lntifactiindAtac ~AM
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Step (2): Click the Change Case button and then select Lowercase option to display all selected words in

lowercase.

4) CHANGE TEXT COLORS IN WORD 2010

This chapter will teach you how to change text colors and how to mark text which should look like it was

marked with a highlighter pen. Finally we will learn how to apply different effects on a text.

Change Font Colors:
By default any typed text comes in black color, but you can change your font color to any of the color

which can imagine. This is very simple to change text color by following two simple steps:
i FeCiiuey,  Shenpeife Step (1): Select the text that you want to

change to a bold font. You can use any of the

= 3 B4 text selection method to select the text.
B/ U-dax w E-¥-A ﬁ;!!l—_;{-‘-_-‘_l'.

Floemy iy WM i Step (2): Click the Font Color button triangle

to display a list of colors. Try to move your

mouse pointer over different colors and you

will see text color will change automatically.

You qﬁn select any of the colors available by

] simpﬂj clicking over it. =

> If you click at the left portion of the Font Color button, then already selected color will be".applied to
‘the text, so you would have to click over small triangle to display a list of colors.

> If you do not find a color of your choice, you can use More Colors option to display color pallet box

which allows you to select a color from range of millions of colors.

5] Highlight Text with Colors:
You can highlight a selected text using any

color and it will look like it was marked with a

ot
T buflding dovha, Whas you of

W-.:;.- e with el Jog v . . .
AN <M using yellow color, This is very simple to

You can saslly change the [ meiung of svlocited taid in the dos

ﬁﬁ S— ) . ' 4 o »
“- 'w”w'm" =2:l.ll highlight a text with a color by following two

o )

simple steps
Step (1): Select the text that you want to change to a bold font. You can use any of the text selection

method to select the text.

- it ara dutl & .o
u.ﬂ.kﬂlmﬁ“‘;,‘,‘,”‘.’"m;&m L2l highlighter pen. Usually we highlight a text.
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any of the colors available by simply clicking over i,

5) TEXT ALIGNMENTS IN WORD 2010

There are four types of paragraph alignment are available in Microsoft Word left-

: aligned, centered, right-
aligned, and justified. :
Left Aligned Text:
T Altgn Test arc s Lot an . A paragraph's text will be said left
ﬁ_li qvt;f.-\;t:-;n;-:.-_kc_.._\: = fﬁawq'm“ﬁ'@&‘. SR
Syl (-:.::-: ~~-:::-ﬂ;; ':;“:-:;' a;.:“;u e aligned if it is allgncd With ]eft
A a "3 e e w 1 i i
R, e . e = margin. Here is a simple procedure to

make a paragraph text left alj gned.

Step (._._1): Click anywhere on the
paragl-z{ph' you want to align and
click Align Text Left button available

on Home tab or simply press Ctrl +

) | e ttaras S L keys.

A paragraph's text will be said center

aligned if it is in the center of the left

=miwm
TN A [ e

and right margins. Here is a simple

center aligned.
Step (1): Click anywhere on the
paragraph you want to align and

" click Center button available on Home

" tab or simply press Ctrl + E keys.

Justify Aligned Text:

A paragraph's text will be said justify aligned if it is aligned with both left and right margins. Here is a
simple procedure to make a paragraph text justify aligned.

procedure to make a paragraph text .
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[y S Braadify Bueshmee '_ ) U ANATImad Wb agpr s , ' -1
sy e ,,_,_“" ] LIS Step (1): Click anywhere on the

(NS

paragraph you want to align and
click Justify button available on Home
tab or simply press Ctrl + J keys.

When you click Justify button, it

P R e e

I T L A I et e LR LR

ar Vom gl g e Ve baker At L u-n AR e R o.

ey 'u-- A T B T T e L A q-tn
v e awad nl\q R TS -w-.n [ S lu Ao vl eean b - e LIS T BT S
e T e e R Lt - iy viny e Cwyisan Tk VD e Fi u~ i (el
e -..u-.nmn u.-v. u-nuh\-—t n; At thi w-ﬂ-kt-vm 4 9wl i, ru
R4

A e S o S0 e o SR i o o displays four OptiOHS, justify, justify

low, justify high and justify medium. You need to select only justify option. Difference between these
options is that low justify creates little space between two words, medium creates a bit more space and
high creates maximum space between two words to justify the text,

6) CREATE BULLETS IN WORD 2010
Microsoft word provides bullets and numbers to put a list of items in a nice order. This chapter will teach

you simple steps to create either of the bulleted or numbered lists in simple steps.

" Create a List from Existing Text:
This-is very simple to convert a list of lines into a bulleted or numbered list. Following are the simple

steps to create either bulleted list or

”‘"’"“""'"?T.ﬁnm,.m sty numbered list.

" Ny Ave e i) GRL

iy it IR L_-_‘._?’.'. i ‘-T'J- Step (1): Select a list of text to which you

: n&;:ys;ﬁquqmmw.u;n,wﬁ m,‘ﬂ ]
-t want to assign bullets or numbcrs You can

use any of the text selection met.hod to select

the text.
Step (2): Click the Bullet Button triangle to

‘-_.,,:.-,-‘-.-Iﬂ".. -ﬁna ,zw .-. e H"T"{f t

display a list of bullets you want to assign to the list. You can select any of the bullet style available by
simply clicking over it.

Step (3): If you are willing to create a list with numbers then click the Numbering Button triangle instead
of bullet button to display a list of numbers you want to assign to the list. You can select any of the

numbering style available by simply clicking over it.

7) SET LINE SPACING IN WORD 2010

Line spacing is the distance between two lines in a Microsoft Word document. You can increase or
decrease this distance as per your rcquifemcnt by following few simple steps. This chapter will explain
how to set distance between two lines as vell as how to set distance between two paragraphs.

2 L1

.05
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Spacing between Lines:

Following are the simple steps to adjust spacing between two lines of the document.

Line and Paragraph 1pacing Button

cu s A A ke W IE-E-T S vl
Pl ey A WA Euwmm I > L
f %" Py — N ] |
T ST e W Wi Wi S R A S0 S e S R ¥ | 3|

’ O the Wuart ek, thee g alaries buhwde fors thet are desig
Lhn!pul‘l

et dirwctly by uning the Dor comarols oo the Meme Ll cE
Vg Tha lnsh o Py saTerd Thecke o teing & farmat &

=5 Fo charge e overall ook of your doeumant, edosse pew |

I e T ST
e =

Ty,
- -

by simply clicking over it.

Select the paragraph or

Step (1)
paragraphs for which you want to define
spacing. You can use any of the text
selection method to select the paragraph(s).
Step (2): Click the Line and Paragraph
Spacing Button triangle to display a list of
options to adjust space between the lines.

You can select any of the option available

Spacing between Paragraphs:

You can also set distance between two
paragraphs. Following are the simple steps to
set this distance.

Step (1): Select the paragraph or paragraphs
for which you want to define spacing and
click the Paragraph Dialog Box Launcher
available on Home tab.

Step (2): Click before spinner to increase or

decrease the space before the selected

paragraph. Similar ways click after spinner to increase or decrease the space after the selected paragraph. Finally

click OK button to apply the changes.

You can use Line Spacing option available at the dialog box to set line spacing as we have seen in previous

example. You can try it yourself,

9) BORDERS AND SHADES IN WORD 2010

Microsoft Word allows you to place a border on any or all of the four sides of selected text, paragraphs,

and pages. You can also add many type of shading to the space occupied by selected text, paragraphs, and

pages. This chapter will teach you how to add any of the borders (left, right, top or bottom) around a text
or paragraph or a page and how to add different shadows to them.

www Jntufastupdates-com
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Add Borders To Text:

Following are the simple steps to add border to any text or paragraph.

Huruh !G"el'lmﬂon‘ Bordes Qutton
= uq.¢ 3 S I Do ¢ Mo Wog T v:-(.mi‘_ﬁ‘:
o bust Papbtwmat | Grwesem tufem berem  Ves  sesdw ) :__O
& Cmam gsam -u ErE-"5 | "

El:;. BJ g Fean-Li é:é’\ i
T aweAa AW Rl 3y g ST i
1owaw . e —] — B Pt ] = '-‘-—“:.——«-— e
| T e v s mnin L o s’ G T -',.‘—.4—:;.59_5;-...-*!51'
f‘ feraetnidag !l torvee 'm—hﬂa ‘q
R e pwuﬁuwm:q )
B e B o 7o rvata pictret charts, o R
1] Bapeeuteyelintog @ &tman pemact ks, ¥

1 e O Fagsn = £

J__ m:nculyth-‘-ue [P | in the doCrmarT wat by thoosing 3 I
! fock for the seecd ey 7y en the bome Lab, You c3m ot format }
ar et ety y g e e o Mot controls cfier » thoice of i
Pl ming O vk bom e | T et Bt you soecify Srecty -
& \. SapasCogm i )
;‘: Te change we cweralic maaad g | newr Theme eiements oa the Page 3
I Lysath Tedasget S Pt ee thhmwnhm.’muﬂ ?E
Sl Ok stve Setcommar nf 2w tian 1 B3 Quick 508 alavy provde resst =5
R ok 1o Bol yon | 13 v rgten Fyour documn > 10 U enigivat - :i
i3 "'-—-du-nxm-,a Bpdert gmd tmasag H :_-_.

margins
Add Borders To Page:

Step (1): Select the text or paragraph to
which you want to add border. You can
use any of the text selection method to
select the paragraph(s).

Step (2): Click the Border Butten to
display a list of options to put a border
around the selected text or paragraph.
You can select any of the option
available by simply clic-:ldng over it

Step (3): Try to add different borders like
left, right top or bottom by selecting
different options from the bordez options.
Step (4): To delete the existing border,
simply select No Border option from the
border options.

Note: You can add ;__:horizontal line by
selecting Horizontal Line option from the
border options. Otherwise type — (three

will be created between the left and right

You can add borders of your choice to word pages by following the simple steps given below.

Step (1): Click the Border Button to
display a list of option§ to put a border.
Select Border and Shading option
available at the bottom of list of the
options as shown in above screen capture.
This will display a Border and Shading
dialog box. This dialog box can be used
to set borders and shading around a
selected text or page borders.

www.Jntutfastupdates.com”
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Sf;:p (2){ Click Page Border ta.b".wh‘ich wi.ll displa}; a list of border séllings, styles and options whether this

border should be applied to the whole document or just one page or first page.

Step (3): You can use Preview section to disable or enable left, right , top or bottom borders of the page.

Follow the given instruction in preview section itself.
Step (4): You can customize your border by setting its
color, width by using different art available under style
section,

You can have similar or even better borders as given

below.

SET TABS IN WORD 2010

Microsoft Word tabs help in setting up information properly within a column. Word enables you to set

left, center, right, decimal, or bar tabs to line up columnar information. By default, Word places tabs

every .5 inch across the page between the left and right margins,

| Tab Description - } i f'
| Left Left-aligns tcxt at tab stop and this is the default
tab.
Center | Centers text over tab stop. {
Right Right-aligns text at tab stop.
Decimal | Aligns numbers at decimal point over tab stop.
Bar Creates a bar to separate the text,
Setting a Tab:
e ——

-
i

P P g
--- _|'

YR TS t‘r‘:r"‘aW-n:

e ..” A
" Il,m--vl = v s BAM "‘

.

D e et T P U NP St Yo Sk

Following are the simple steps to
set center and right tabs in a word
document. You can use similar
steps but different tabs to setup

decimal and bar tabs.
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Step (1): Type some text that you want o line up with tab stops. Press the Tab key only once between

each column of information you to want to line up. I typed following three lines

Tab batton
Acentertal appean

R : et W
ekt . 4 L

= rol
l Cmem -V A4 dar W ;tirla '_:,\- un;\::}-uhﬁ-t ADBL | '1\ fn

_‘,lt| "“'\'-3..1\..,; “"Iu«lmu—- N—.\il';:\m.n:u
st oy

a T S e i bie T ...‘._ —x7 .::‘.'.':A‘--. I -—ﬂk-, T I AR ey
R 3 % oo Gl TR AT

*-»w-. Tekdies
S g g el

n
Smemairal ‘q—AM R S oR A SRR

3 e
o = Aig
h'-swl‘{!—-” - R L T S R TR = e b A e i,lgli'."&sﬂ tﬂ%w’im\}i‘ W._J

A cenlzrtab appears A rightt taly appears

Step (2): Select a tab type using Tab
Button, let's say center tab and finally select the
paragraph or paragraphs whose tabs you want to
set. Next click the ruler where you want the tab to
appear, a tab will appear at the ruler where you just
clicked and selected text will be adjusted in the

Cerniter.

Step (3): Now select right tab using Tab
Button and click the ruler at the right

side where you want to align text at right

e s s

side. A right tab will appear at the ruler
where you just clicked and selected text
will be right aligned.

!
)

P e PR L Y ST

o

{ i

Moving a Tab:

You can move an already set tab at a particular location by following the simple steps.

s apm 2ars hore ollar rave

O W | paioedigre
I Foa sraa Satgrminns
B Catem aas S T L
‘da W Qo w | -o[ o O Be-  [E-
o) ‘..w.‘ As-l A A [re]we e A1 N | disssc Metaar

e G eaaaral | vyt whar T A PR A A ) ARLAT

ST Raraw wine [EEE W 7 ]

1 G- ‘n-mn 'llt- Ll

o s f»ﬂ?, oqpma el i s

Step (1): Click just before the line for

which you want to change the tab setting.

L]

tab, the text moves with the tab,

www.Jntufa
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" Drag the tab sign available at the ruler to

‘!he_leﬂ or right,

e ——r—

Step (2): A vertical line marks its position
as you drag and when you click and drag a
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ADD HEADER AND FOOTER IN WORD 2010

Headers and footers are parts of a document that contain special information such as page numbers and
the total number of pages, the document title, company logo, any photo etc..The header appears at the top
of every page, and the footer appears at the bottom of every page.

Add Header and Footer:
Following are the simple steps to add header and footer in a word document.

Step (1): Click the Insert tab, and click

cither Header button or Footer

button whatever you want to add first.

i ]
Assane you are going to add Header,

et ace dusignad 1o coordinets wih we ver*H 50 When you click Header button it

] fasies ta insert tables. headarx, footers, Hsta, el

S i w, W ' s har £ N . . . . :
ﬂou-:.r;.-‘{l" e | 4o dn::::n::‘ e el will display a list of built-in Headers
R TY T S —— mi 14aY In the documant Text by choosing & |
| ook for che ul ———— l % gellery on the Homa teb, You can slso formuy from where you can choose any of the
S emaumdnyl Home :-6. Mot controls offor a chalzce of 3 i i ;
J oming the 1o — ) . .
gt} Lo headers by simply clicking on it.
|t aragiosern = T "
Edir sulit-in siyies .
e i posist sikiing Step (2): Once you select any of
Insett tab Selecied Header Close Header and Fonter

the headers, it will be applied to

N Mmooy MR FORSANT P g

M men nonum M-mu- nlmm l.nmm ‘\r.nv Addin IM BNIM
Ty Jmm- i* -I .‘_'\'. ) gnnu s

P § = W et ol o L}- Ladem 3

12 [ Gt Opham | Crone Headd

22 Page bumber - | 2 l-.':.a & cup en ":q.:i ’n‘:l L) - 3 | -nlo'l'dnr" !

_mlon L festien | i

the document in editable mode and

the text in your document will

appear dimmed, Header and Footer

buttons appear on the Ribbon and

a Close Header and Footer button

will also appear at the top-right

took of your dacument. You ¢an une thiww gallerles 1o e ) abiue, headars, footers. lisis, |7
fover peges, and other dnocumen bullding blocks. Whaen you crvele pitiu ey, charts, or

3B lﬂllﬂ"'! they alio coordinuie wath youwr current dodument lock comer.

e e— e — —
—_—

— —_—
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s Becumestmeeder ¢ Step (3): Finally you can type your

[ R R B A T “#=4) information whatever you want to have
seme ae Faor tagm Feraswn [SELrT] e - a s o
£ =l e R

b O Canse Poe =i ky

in your document header and once you

‘u R I I T R ‘*:a N .- :“}l r e Cranas taaing
b AL SN __\. Aas A a" lewiw | . Aryien » bintay = .
e eani & ey bt | are done, click Close Header and Footer
\ o} 11 S ¢ RO | U Y ,L'»

to come out of header insertion mode.

- M .
Word Trating Document i You will see final result as follows.
l

On the Ineert tah, the gallerias tnclude Itema that are designed to rpordinate with the overs . cdure to
I-:kqvl’vw- Aoturnent. Vou cen e thews galleries ta Insart tables. hasders, footers, llsve, :: You can fO"OW a Slmllar proc
Cover and other document bullding blacks. When you crosta pictucas, chars, or | .
£ d-c-:::-' *ho coordinate with your current document fook. oy - [.. I add footer in your document.
o e D g )
< Pwpwd S | weees A3 § a3 !mp.\H_J Lo, el Alagim ey ey A LN (= \ﬁ"u‘!‘ a7 (" -

Edit Header and Footer:
Follow the following simple steps in case you want to edit existing header or footer of your document.

wsertish Moader & Footer Buttons,

reer

S e ',,", RS A mnm;MMwﬂ
Inser B hg-u,m B tisrs! l!nhm;l

Tew AT it

ave Addna y

Step (1): Click the Insert tab, and click

. SRS €] n_‘:’.l E i} a .'_‘Ivuda- j&lnh-u-g— P i . h H d b N I‘: .
i o - e ader utton or Footer
ape —al — I \ut Humar = ng,\-- s pree San - Y- MM either He
MA-PB;I 2 ‘, % rr.v! .
=t 1 s .'3.4'.:,1..' IR ERR | R T §‘- button whatever you want to edit.
- =1 ' = L
On the Insen —— Hutarededumdwwﬂa;ww‘hﬂmmu Assume you are gomg to edit Hcader‘

tack of your Al — e [ tartes to ingert tables, headars, footars, lists, |2 :
3 Eks. When you creste pistures, charts, or g
1
i

e document losk, so when you click Header button it will

Yo com wasl o ¢ 1extin tha documens tent by choosing » | [l digplay a list of options including Edit
1] Yook for the 1] R e a gallery an the Home tab,. You can alsa !o'mq"! -
i [ e Y M Homs b, Mowt conuais cffer a cholce of l i .
-} g the doo T — - -8 # forr farmat that yo spaclfy drecdy, [, H  Header optlon.
o M g | et Wt = : 1 i
e T Py i |
l-.-----———-——-—: e | !

okt Meador optian  Bullt-n iaadar styley Step (2): Just click on it and word will

display editable header for you as shown below.

{ { f ;
Step (3): Now you can edit your document header and once you are done, click Close Header and
Footer to come out of header edit mode.
You can follow a similar procedure to edit footer in your document.

ADD PAGE NUMBERS IN WORD 2010

Microsoft Word automatically assigns page numbers on the pages of your document. Typically, page
numbers are printed either in header or footer but you have option also can display the page number in the
left or right margins at the top or the bottom of a page.

Add Page Numbers:

Following_are the simple steps to add page numbers in a word document,
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|
: ‘ |
.‘.; . -‘ : ! ' R .: '. e = / ,'_ LA S ‘ I s
inserttab optien Menu F.IgINurF!h-!lllllton - Step (1)' Cth the [IlSCl't tab’ ﬂﬂd i
1R e e ‘ﬂ"‘r‘-"*“*@f‘ click Page Number button available E
“ Hama | tnuenm *rgeino) . LT ava gt r:..u Vi AddInt n € }
T b HAGRT w Jrem] BAQNITR LD in header and footer section. This |
'-?n. h.b." Pchowa iu: \nmu .unn ‘1 hw"m“; ;;:n_ ans |H s o+ !ml.bu'l .
Yamiey _ Muarstions| e < 5 . _— . . .
) i s N i o a3 will display a list of options to E
'  Onthe lnserttab, tha g u Lage basigine » jesigned to coordinate with the nw‘: ) E
look of your document. Cinrent Pesition » Insert tables, headers, focters, lists.§ dlsp]ay page number at the top’ {
covar pages. and othar "ILT Parmat Page Humbers .. " you crestm pictures. charty, or “’ ‘
) R W gy || bottom, current position etc. [
- r You canesslly change the 'mnnulng of selectad text In the document tokt by choosing al . r
ook for the selected text fr he Quick Stylas gallery on the Homa tab, You can alse for — W
ek o e e o e rourots on the Hame 1ab, tort contrals offar 2 choicaof || Step (2): When you move your |
k using the look from tha currant thema or using & format that you upuln directly. ‘: l-
' Whamduin . — : . |
LS T T N T R TN T sy mouse pointer over the available i
. T :
et ot R —— options, it displays further styles of |
T e e Foo RS 25| page numbers to be displayed. For {':'
— ol .-,A P G eastrrmmar - | et sA s er v | . :
Lo | ha E‘.’,.:':."‘.:‘.':,- B example when [ take mouse pointer F
. i (8 LA ;:,..._j:.:?.'-:,l:..,:.;";;..~ ot =
| S mmenmIRI e || at Bottom of Page option it displays b
L - T s e e el ollowing list of styl
e A e L i z|| following list oI styles.
:.-'.'-*-*-—————--’:—--—— o e e SR o Loies .
o :_Jr e vame iy Step (3): Finally select of the page

number styles which you like most. I selected Accent Bar 1 style by clicking over it. After this step you
will enter in Page Footer modification mode, so you would have to click Close Header and Footer button
to come out of footer cdlt mode.

You can format your page numbers using Format Page Numbers optlon available under the listed optmns

) fl " o ; ;

! ] [
PAGE ORIENTATION IN WORD 2010

Pagc Orientation is useful when you print your pages. By dcfdult Microsoft Word shows a _page
in porr.raxt orientation and in this case page width is less than page helght and page will be 8.5 mch&s x11
inches. You can change page orientation from portrait to landscape orientation in which case page width

will be more than page height and page will be 11 inches x 8.5 inches.

Change Page Orientation:

Page Larisivialion | Farireis

Following are the simple steps to change

T Ll D s R . [ ,,_,,...- asnr; 2% h i i
e e e A i e b ety 5 the page orientation of a word
-~
:‘:".;":.:—.:-.'::::::.-.1:;:::1‘- Tl document.
e T St s e T SR e e &
S R S T S e e o E T e
Tmrmim o o e e e P e :
o e ) S T Step (1): Open a word document for

maps Helwht
which you want to change the
orientation. By default, orientation will
R R TEII | be Portrait Orientation as shown below.
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cover pages, and athat docurmaat bulldng blocke When gou create pletures, charty, or
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Step (2): Click the Page Layout tab,
and click Orientation button available
in the Page Sctup group. This will
display an Option Menu having both
the options (Portrait & Landscape) to
be selected.

Step (3): Click any of the options you
want to set to orientation. Because my

page is already in portrait orientation,

so I will click Landscape option to change my orientation to landscape orientation.

SPECIAL SYMBOLS IN WORD 2010

Your keyboard may not have many characters available but you want to use those characters in your

document, in such situaticn you have option to insert Special Symbols the way. To insert symbols you use

occasionally, follow the steps in this sccﬁon If you find yourself using a particular symbo] frequently,

you can asmgn a keyboard shortcut to 1t.

Insert Special Symbols:
femeritat i Symbol bution
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Here 1s the simple procedure to apply
zoom-in or zoom-out operation using
view tab:;Step (1) To insert a special
symbol, bring your cursor at the place
where you want to insert the symbol.
Click the Insert tab. You will find two
options under symbol
Equation and (b) Symbols. Click either

of these two options based on your-

requirement. You would use equations while preparing mathematical or scientific or any similar

document. For now I'm going to click Symbol button which is shown below,

button (a) .
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Step (2): When you click Symbol button, a
small list of symbols will appear as shown
below.

Step (3): Now click on any of the available
symbols in the box to insert that in your
document at the selected location. If you do

not find desired symbol in this small box then

e e e A | D

you can click at More Symbols option to have

a wide range of symbols as shown below in the symbol dialog box. You can select any of the symbols and

then click Insert button to insert the selected symbol.

InpnoEEoppoaEnOan

; —
: L,f__._rj Ema -/ 2

symbol Dlslog Sox

EQUATIONS WITH WORD 2010
EQUATION EDITOR

When writing a document which primarily
covers mathematical signs and equations then
using Word 2010 built-in Equation feature
would 'be of great help. In Word 20101E you can
insert Equation from the built-in list instantly.

Handling equation that you have written by

yourself would be a bit tedious fask to get by, but through this feature of Word you can manipulate them

by performing simple actions and clicks. In this post we will explain how easy it is to use Equations in

Word.

Launch Word 2010 document, in which you want to insert any mathematical equation.
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Question 1: |
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Now nzivigaté to Insert tab, and Click Equation drop-down button to view built-in list, containing

different equations.
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Upon click desired equation from list, it will be automatically added into the document. Now click the
drop-down button being present in the equation box for more options, click Change to Inline, to place it

in the line you were editing.

Question 1:

Fi
s‘vﬂ' as NI‘\# Ecquation...
% Prafessiunal

£ Lluur i )
eangetainmne )
] dJustitication — [3
L e *’
Upon click, it will be adjusted properly in the line, as shown in the slcreenshot below. j
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For editing equation values you need to click inside equation box to change values manually.
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For viewing it or checking equivalent linear equation,
Linear.

click drop-down button in equation box and click
You can also save the newly created equation through single click on Save as New Equation,
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| l‘;‘HCi{OSOF'l' POWER POINT

Creating New Prcsenlnlions

When you open Po“ erPoint from the Start menu or from an icon on your desktop, a new presentation

with one slide appears by default. You can also create a new presentation while PowerPoint is already

open.

Click the Microsoft Office button, and choose New from the menu.
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Click Create, and a new presentation will open in the PowerPoint window. :

The default slide that appears when you create a new presentation is a Title Slide layout.

Slide Baslcs
About the slides:

]

T

v
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- Slides contain p'lncehold'ers,' or

areas on a shdc thal are enclosed by doucd borders. Placcholders can

contain many different items, including text, pictures, and charts. Some placeholders have

placeholder text—or text you can replace— and thumbnail-sized icons that represent specific
commands such as Insert Picture, Insert Chart, and Insert Clip Art. Hover over each icon to se€ the

type of information you can insert.

P‘*"'f**'-! Cllck to add t|tle—mac-w-v=m |

e e A e e e g i o i)

e = e R e P — .__.._1‘

I C“Ck to add text- Placetelder text E

|
|
}

| sy
Piaceholder= |

i
@

2, 3 Iconzlo mzed
= . Lk vanous types of i
re irforriatiasn ’

About Slide Layouts < T

The placeholders are arranged in different layouts you can select when you insert a new slide or that can

be applied to existing slides. In the example above, the layout is called Title and Content and includes
title and content placeholders A slide layout arranges your slide content. Layouts contain different types

of placeholders you cad use, depending on what mformatlon you want to include in your presentation.

Each layout has a descnptwe name, but the i 1mage of the layout shows you how the placeholders are

arranged on the slide.

3
f
i

To Insert Text Into Af Placeholder:

Click inside the placeholder. The placeholder text will disappear, and the insertion point will

appear.
Type your text once the insertion point is visible.

Click outside the placeholder when you have entered all of your text into the placeholder.

When you enter text or use the icons to insert items, the placeholder text and/or icons disappear as soon as

you start typing.

95

I
|

www.Jntufastupdates.com
Scanned with CamScanner




To Insert A New Slide:

Click the New Slide command in the Slides group on the Home tab. A menu will appear with

your slide layout options.

Cortent with
Capran

Click the slide you want to insert. A new slide with the chosen layout will appear in the center ot the
PowerPoint window and in the pane on the left.

To Change The Layout Of An Existing Slide:

Select the slide you want to change.

. -1
i |
'

/ i {
Click the Layout command in the Slides group on the Home tab. A menu appears with your options
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" To Copy And Paste A Slide:

Select the slide you want to copy.

Click the Copy command on the Home tab,

Click inside the Slides tab on the left task pane. A horizontal insertion point will appear.

Move the insertion point to the location where you want the copy of the slide to appear.

inserticon Peaint

To move a slide:

Select the slide you want to move on the Slides tab in the left task pane. Click and drag the
slide to a new location. The insertion point will appear, Release the mouse button, The slide

will appear in the new location

Saving your presentation

If you are saving a document for the first time, you will need to use the Save As command; however,
if you have already saved a presentation, you can use the Save command,
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T o-Use The Save Comﬁmnd:
Click the Microsoft Office button.

Select Save from the menu.

Using the Save command saves the document in its current location using the same file name.

(F) Applying Themes to slides, Inserting Pictures, Smart Art, Clip Art, Shapes and Chats into your
slide. '
To Apply A Theme:
Select the Design tab.
Locate the Themes group. Each image represents a them

Click the drop-down arrow to access more theines.

me of the theme will appear as

Hover over a theme to see a live preview of it in the presentation, The na
180 slide SHaw

you hover over it. 5 . Desig ians

lil Aa Aa

)1 eszaag E@mam@E

S |

.'.d:,'” Biowie ter 1hemes...
VT | amwe Cusert Thame,.,

osefl QIfice l.'Jnlwm.u' .

— T

Click a theme to apply it to the slides,
Yo can access additional themes on Microsoft Office Online or create your own.

Fonts that are changed with the font size and style menus will not change when you apply a new theme.
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To iﬁ;crt A Picture Fr(in; lec Ribbon:

Select the Insert tab,

Click the Insert Picture command in the Illustrations group, The Insert Picture dialog box will

appear.

Design Animations

urm@@

Pldme Clip - Photo Shapes SmartArt Chart
: Art Albumv v

I G ea o RS T e

=S [-"--ms' — ity '-;-"':-;- [ T T AL N SV Y Sl e arr e pupgp i — j
C =) . L_r.-x.\_l | |
Click Insert,’and it will appear on the slide. / f

To Insert A Picture From A Placeholqcr Command:

Click the Insert Picture command in the placeholder, The Insert Picture dialog box will appear.

- Clickto add text

'I‘\I-\vwb-lvlp ull
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e mictere vou want to use. Click Insert, and it

will appear on the slide.

To insert a dip art from the Ribbom:

[adect the Imsert tah
CBck e Clip Art command in the IMlustrations group. The Clip Art task pane will appear on the right.

Design Animatians

Enter kevwords in the Search field that are related to the image you want to insert. Click the drop-down

2mmow pext o the collections field

Select Everywhere to meke sure PowerPoint searches your computer and online resources for an image

that meets your citenia. Ot o=t %
: - | g
Search for
le | lee |
Searchin:

E@Oﬁtetolecums
= i) web Collections

Click the drop-down arrow in the media file types field.

Deselect any file types you do not want to see. In this example, we only want photographs, so we'll
deselect the other options. L A e

Search fory

[lea i TS
Seacch v

[ A8 covectians . =~
Resube atadhd e

[setectad media tie types =)

= ] Al media tynes
w O A v
i B Photographs

E?
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Click Go: A listof clip art fmagé.s relatec_l. to the search terms is displaycd. d

' S&arch I'D(]

(= T I =
Search Int

(Al collactions el
Resulty chould be:

[Sulectad medla Flle types LV;I

Click a clip art image to insert it, or click the drop-down arrow next to the clip art and select Insert from "

the menu. The clip art will appear in the slide.

To insert clip art from a placeholder command:

Click the Clip Art command in the placeholder, The Clip Art task pane will appear on the right.

i S I r T

Team E rcise

> = = L LT T SRR F Py e Srg A TN
= Click to add fext ] Ti's Click o add taxt ™
1 §
f f
: o] el 7 4 — g
loes] 3 25 sl B3 ’1-,-1;
Chp An
<> i L

Enter keywords in the Search ficld that are related to the i nnage you want to.insert. Click the
drop-down arrow next to the collections field,

Select Everywhere to make sure PowerPoint searches your computer and online resources for an
image that meets your criteria,

WWW. Jntufastupdates com
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Click the drop-down arrow in the media file types field. |

Deselect any file types you do not want to see. In this example, we only want photographs, so

we'll deselect the other options.

Click Go.

A list of clip art images related to the search terms is displayed.Click a clip art image to insert it,

or click the drop-down arrow next to the clip art and select Insert from the menu. The clip art

will appear in the slide.
To Imsert A Shape:

Select the Home tab,

Click the Shapes command. Click a shape -

from the menu

Move your cursor toward the slide. It will appear as a cross shape.

Click and hold down the mouse button, and drag the cursor until the shape is the desired size. o
i '

; I ;’ !
Release the mouse button to insert the shape.
To Change A Shape Style: - _‘ '.
Select the shape The Format tab will appcar Select the Format ' '
tab.

Click the More drop-down arrow in the Shapes Style group to display more style options. {l

Drz_iwlng Toals

'.fﬂnnew lesson9i= Mlcro:ofg Powerpomt )

p07 _CompanyQd

ﬂmmation.

v ‘{a Shnpc Fill -
- {2, shape Outline ~
£ shape Effects ~

Choose & visual style for the smpe
or jine.
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Move your cursor over a style to see a live preview of the style on the slide,

Click a style to select it.

To Insert A Smartart Graphic:

Select the slide where you want to insert the SmartArt graphic. Select the Insert

tab.

Select the SmartArt command in the Illustrations group. A dialog box appears.

Insert ., BRPLHEL Animations
: 1

=l BE g D | T g
|| pictute Clip  Phote Shapes |[SmartArt| Chart |

At Album< -
e fustratans LA TR

Select a category on the left of the dialog box, and review the SmartArt graphics that appear in the

center.

womrasy & SusartAst raphkc

'

{ f . _
' | DD z-“ -.gm .::f

Co= ) Ce== 1

Click a graphic to select it. A larger version of the graphic, along with text details, will appear on the

right side of the dialog box.

e
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Click OK. The graphic will appear on the slide, and two new SmartArt Tools tabs— Design and

Format—will appear on the Ribbon.
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You can also insert a SmartArt graphic by clicking the Insert SmartArt command in the

placeholder, if the slide layout includes a content placeholder.

How to apply Default and Custom animations to text and Transitions to slides in your
presentations.

To Apply A Default Animation Effect: : o

Select the text or object on the slide you want to animate, Select the
Animations tab.

= D l 4
Click the Animate drop-down menu Iin the Animations group to see the animation options for the
selection. The options change based on the selected item.

A/ No:-Animation
Fade
W Wipe
Fly In
} Custom Animation.. ¥

L

Move your cursor over each option to see a live preview of the animation on the slide.

Click an option to select it.

o]
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To apply a custom animation effect: -
Select the text or object on the slide you want to animate. Select the

Animations tab.

Click Custom Animation in the Animations group. The Custom Animation task pane will

appear on the right.

Click Add Effect in the task pane (0 add an animation effect to the selectad text or object.

Select Entrance, Emphasis, Exit, or Motion Path to display a submenu of animation effects for

the category.

B Lbungs PR nionce gL
& 2B: ¥§ Emehashs » f i \_]
By 3 Checkerboad M ’ v| .
S 4 Diamond lﬁ' Motion Paths ¢ i]
14 Shyi .
e || gy
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Entrance: Changes how the selected item appéurs on the page

Emphasis: Draws attention to the selected item while the slide is displayed o Exit: Changes

the way the selected item disappears from the slide

Motion Path; Animates the selected item s0 it moves to a specific place on the screen

Select an animation effect to apply it.

SRREH
: & |Gy Add Effect: .E-’fﬁ ﬂflrnm'-n’;-_i :

® LEnes [ Entence b
a"j\—i..aox_ - k ¥¢ Emphasis . b SRt
S 3. Checkerboard | WE Exit » "*‘""—M*—J
S% 3. Diamond ¥ Motion Paths » T ]
& S Fyln E i ESRE——— =5
Mare Effeds... || swicr an atemant of tha sitde, then
———— - = click “Add EFfact” to add animations”

The animation will display on the selected item on the slide and will appear listed in the Custom

Animation task pane.

Mission Statement

+ Te cmpoa-'e sledenty 10
become oy learners i
: v D P11 ¢ Contors Pacehoin... %]

+ To prowide an cpen
emaronmers for learning

o To halp Lted ars s AORAIe
Tha computat Walls they

need te sugcred i Vhe

2V= camtimy

¥ [7) s tsay wviave

A number label appears on the slide next to the animated object. A matching number
label also appears next to the animation in the Custom Animation task pane list.

Drop-down menus appear at the top of the Custom Animation task pnné. You can

define the animation effect in greater detail here.
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' The star Play Animations icon appears beneath the slide on the Slides tab in the task
pane on the left. It indicates that the slide has an animation effect.

To Modify A Defauft Or Custom Animation Effect:

After you apply an animation effect, drop-down menus will appear at the top of the Custom

Animation task pane. The menus vary based on the animation effect.

Select an 6ption from a drop-down menu to change the default setting.

[sfr- change :] %o Remove. |

i
i

Modify: Blinds .
* Start: : [“_a on Click.
Direction:

Horizontal
"%+l Horizontal ‘& i»

Speed:

Vertical

Repeat until all menu options are at desired settings.

To Remove An Animation Effect:

Select the text or objec"t;on the slide you want to modify. Select the °l
! i

Animations tab.

Click Custom Animation in the Animations grou"*p. The Custom Animation fask pane will

appear on the right.

Select the animation in the Custom Animation task pane list, if it is not already selected.

Click Remove. The animation label will disappear from the slide and from the Custom

Costonyan

Animation task pane list.

Changs v (% Remave ﬂk

Modily: Blinds

Starti [*B on click 14|
Direction: Vertical L\ﬂ]
Speadi Fast indl]

(6 Conton Facehoti... ]
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To Preview An Animation Effect:

Select the text or object you want to modify on the slide. Select the

Animations tab.

Click Custom Animation in the Animations group. The Custom Animation task pane will

appear on the right.

Select the animation in the Custom Animation task pane list.

Click Play at the bottom of the task pane to see a preview of the animation in Normal view.

OR

Click Slide Show to see the animation in Slide Show view. Press the Esc key to return to

Normal view

r_ﬂmlil'yv Dl
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To apply a transition to one slide:

[Z] vt orroviaw

Select the slide you want to modify. Select the

Animations tab.

Locate the Transition to This Slide group. By default, No Transition is applied to each slide.

.| ¢ lf,-. ﬂrvnm View !

o B e I uu]u Qe ]!!I’l vll
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Advance Slide
On Mouse Chick
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- Clitk \ie More drop-downi arrow 1o disp'lny all available transition effects.

Anunq"nn-
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mﬂJ sy |}, |y B
|-a-sJ | ] (B | | (B ()|
(=) (=] () ) (i) ()|
()] (Deei)] (D) |wREH] |REsST] (PESFY) LS

Click a slide transition effect to apply it to the selected slide.
Hover over a slide transition effect to see a live preview of the effect on the slide.
To apply a slide transition to all slides:

Select the slid;c you want to modify. Select the

Animations tab.
Locate the Transition to This Slide group. By default, No Transition is applied to each slide.
Click the More drd';?"-down arrow to display all transition effects, Click a |

slide transition effect to apply it to the selected slide.

Click Apply To Allito apply the transition to all slides in the presentation.

Anlma'uons

P

=

Slide Show + Review . = View Add-Ins .

How to insert Audio and Video files from system into the Presentation,

To Insert A Movié From A File On Your Computer:

Select the slide where you want to insert the movie. Select the
Insert tab,

109

www.Jntufastupdates.com
Scanned with CamScanner




& mj) zﬂ s E;J |
O Pacts \mwﬂmm Chact ]‘ 1"}1¥‘1I -m:a @ ‘gude wz'! Obm\ _
ﬁ{cﬁé Seund
é @ Moﬂef!em Eilcm E
anu- from Gsp Crgantx.:r - h
Locate the file you want to insert from your computer. ir
Click the file name.
Click OK. The movie will appear on the slide. The Movie Tools Options tab and Picture Tools L
| | - - I- -F . ‘l'
f Format tab appear on the Ribbon when the movie is'inserted.
f o
— R Tt T F- '
T AT T Ay T v T S S e e e A T e T e reeah 4
A dialog box will appear. Click Automatically-or When Clicked. Automatically will start the
movie automatically as soon as the slide appears in Sllde Show view, while When Cllcked will
start the movie when you click. "
|
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Microsoll Oifice Powerloind

L@ Mow do you want the mavie to ftart In the thde show?

EM_JC___J

To Preview The Movie:
Select the movie on the slide. Select the

Options tab.

Click the Preview command in the Play group.

» Microgoft PowerPoint Peture Tosls | Movie Todly
Feview \mn Add I I'mmt

| Ry J»;;[Ammua; -i Loso U s:nam

| ] tece Dunng Show Tl Rmnd!.m alter Paping |

| Bringta Sendto ‘kr«hon Algn Gieup Rlate
LET Moy Rt Soeen Front~ Back=  Pane A *

Press the Preview command again to étop the movie before it finishes playing.

To Change The Movie Volume:

Select the movie 6n the slide. Select the
Options tab.

Click the Slide Show Volume command in the Movie Options group. Select low, medium, high,

or mute to change the movie volume
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To Change When The Movie Starts:
Select the movie on the slide. Select the

Options tab.

Select the drop-down menu next to Play Movie: in the Movie Options group to change whether
the movie plays Automatically or When Clicked.

Desmn arumatmn, Slide Show

m’ Play Movie; Au!onaﬂcalb' fﬁ Loop Untii Stesped
[: Hide Durinig Show ] Pewind Movie After Playing

Shide Show ‘
[F] Play Full Screen

Volume~ '

|
To Delete A Media Clip:
Select the movie from your computer or the clip organizer; Click the

;
f f

Delete key.

To Insert A Sound File From Your Computer:

Select the slide where you want to add sound. Select the

Insert tab.

Click the drop-down arrow on the Sound command in the Media Clips group.
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ound from Clip Organizer,,,
Play CD Audio Tratk...

Record Sound...

Locate the sound file on your computer.
Select the file. |
Click OK. A sound icon and a dialog box will appear.

{7 v ran

et
e e Py ) T T T T

T :

i

Select Automatically or When Clicked. Automatically will start the sound automatically as
soon as the slide appears in Slide Show view, while When Clicked will start the sound when you

click. e B
Microsoft Office PowerPoint
k%) How do you wank the sound to start In the slide show?
.
[ acomaticaly N [ When Chcked |
To delete the sound;

Select the sound icon,

Press the Delete key on your keyboard,

!

www.Jntufastupdates.com
Scanned with CamScanner




.. MICROSOFT EXCEL

Microsoft Excel is a commercial spreadsheet application, written and distributed by Microsoft for
Microsoft Windows and Mac OS X.

Microsoft Excel is a spreadshect tool capable of performing calculations, analyzing data and integrating
information from different programs.

By default, documents saved in Excel 2010 are saved with the .xIsx extension whereas the file extensions

of the prior Excel versions are .xls,

GETTING STARTED WITH EXCEL 2010
This chapter teaches you how to start an excel 2010 application in simple steps. Assuming you have
Microsoft Office 2010 installed in your PC, start the excel application following the below mentioned

steps in your PC.

Step 1 — Click on the Start button.

A Programs

Step 3 ~ Search for Microsoft Office from the sub menu and click it.
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EXPLORE WINDOW IN EXCEL 2010

The following basic window appears when you start the excel application. Let us now understand the
various important parts of this window,

|
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e Deele - . o

): aele E sor fc Fiod &

) fomeat ¢ | LeT Futer Y Swlect ™ |
Lt e e

e

a0 () “
.;:.:-:-—mvz-:-swrgs-_irn.-‘w_-! T e TR T TR T
N )

)
Sk g T
Ak N . . - . .

| 3 B T R S RIS L

frow bor’

S
1

t _!‘El‘<
i Lok i |

3o -z_

»1'4%“},61&& m{,,r- e ) AR
\.,___“._-——-—J

Vieww Buttons . Fgom Controls

File Tab: The File tab replaces the Office button from Excel 2007. You can click it to check

create new sheets, print a sheet,

t

the backstage view, where you come when you need to open or save files,
and do other file-related operations. f '
Quick Access Toolbar: You will find this toolbar just above the File tab and its purpose is to provide a

convenient resting place for the Excel's most frequently used commands. You can customize this toolbar

based on your comfort. -
.f | | |
Ribbon:
| Heme baes  Pagelwwsd Cpomias Dt | Resiew "'#ﬁ-& ' .r-dd:in; R DaoFg =8 2
Cﬁﬁﬂ- i - n. - # *2, ] ¢ _. ; - . & %h’\tﬂ - 2? ;? f
B I g- AN g%% Eg - "'h‘ls | 39 Delgte v
- i . X Sont& Pnd &
* Q’ & 4 EF g g’ tﬁ:’iﬂ. ijﬂmu' Q' Filter~ Select = l
fort nl o Augnmerdt il tignoe ﬁ% 1 Cefs Ectng |

Ribbon contains commands organized in three components =
i) Tabs— They appear across the top of ‘the Ribbon and contain groups of related commands. Home,

Insert, Page Layout is the examples of ribbon tabs.
if) Groups — They organ?zc related commands; each group name appears below the group on the Ribbon.
For example, group of commands related to fonts or group of commands related to aligr;ment etc. |

iif) Commands —~ Commands appear within each group as mentioned above.

Title Bar: This lies in the middle and at the top of the window, Title bar shows the program and the sheet

titles,
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Help: The‘Help'Ich can be used to get t:xc.efpelatcd help anytime fbu like, This pro{rid‘f‘:srﬁice. tutorial o
. -~ n
various subjects related to excel.

Zoom Control: Zoom control lets you zoo

of a slider that You can slide left or ri
decrease the zoom factor,

m in for a closer look at your text. The zoom control consists

ght to zoom in or out, The + buttons can be clicked to increase or

View Buttons: The group of three buttons located to th

¢ left of the Zoom control, near the bottom of the
screen, lets you switch among excel's various sheet vie

ws.
i) Normal Layout view — This displays the page in normal view.,

ii) Page Layout view — This displays pages exactl
screen look of the document,

iii) Page Break view

Y as they will appear when printed. This gives a full

— This shows a preview of where pages will break when printed.

represents the location where text will appear when you type,

Row Bar: Rows are numbered from 1 onwards and kee

Ps on increasing as you keep entering data,
Maximum limit is 1,048,576 rows. '

Columns are number_éd from A onwards and keeps'og;l increasing as you keep entering
After Z, it will start the series of AA, AB and so on. Maximum limit is 16,384 columns.

Column Bar: data.

Status Bar: This displays the sheet information as well as the insertion point location, From left to right,

this bar can contain the total number of pages and words in the document, language etc.

You can configure the status bar by right-clicking anywhere on it and by selectin

& or deselecting options
from the provided list

ENTERING VALUES IN EXCEL 2010

Entering values in excel sheet is a child’

sheet. A new sheet is displayed by default when you open an excel sheet as shown in the below screen
shot. '

.com
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Sheet area is the place where you

el - o _ ‘
m 3rni tnset Pagelajot Formul Baty  Rhriaw  Vew Ad3.dne B Gﬂ = E‘,‘f RS )

o % o e ™eg S o op B EVX type your text. The flashing
Ly B X R AN ST T M. . . ) i
bte w A ~_ ‘ Nsther | Stier ‘{"'[ o | vertical bar is called the inscrtion

it 1 !
"-l:.r-bs::—'_i\. e !.\m:*— eI " '—:—H'vl— e B e L r‘ iR \E\:T’:u —.zr'rr::' : - ; .
TR LN v s ,‘. || point and it represents the location
:;]J.____ e - <1| where text will appear when you
| .
:*{ ‘i | type. When you click on a box then
¥t~ ' o
a . [ . . ’
L; ? N the box is highlighted. When you
s | . -
k2 i double click the box, the flashing
8 i
BLF| vertical bar appears and you can
10} o
n} N start entering your data.
(X W

Eorer )

e

s o b IR TR, e

A R ey o

ShestArsd

So, just keep your mouse cursor at the text insertion point and start typing whatever text you would like to

type. We have typed only two words "Helio Excel" as shown below. The text appears to the left of the

insertion point as you type.

@i =5 :nmuﬂ wummw i
n w.meLm-'t P;qeuwm fmlui_ M!‘-Rnn 'mw fgu-m -f
DB ow o w - mwElE T s @ I
s :ll lg'A » i;g‘:ﬁn !nwml suk':‘ccll: f‘g' 2 i T
Foed .;‘ Aligoasend 6 | | | { Eafting |
R . e
B ik c'j (TS R 0 M O T e
}

AL CRgE
LAl !fw&g&wm:-w *w~ *mw

Thcre are following three 1mportant
pomts which would he]p you whllc
typing —

]

!
» ' Press Tab to go to next column.
» Press Enter to go to next row.
> Press Alt + Enter to enter a new

line in the same column.

Excel prowdcs a number of ways to move around a sheet using the mouse and the keyboard.

First of all, 1ét us create some sample text before we proceed. Open a new ‘excel sheet and type any data.

We've shown a sample data in the screenshot
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'(')r;]cr!Da'tc“ o ‘chi'o‘n Reﬁ Ttem Units Unit Cost Total
1/6/2010 East Jones Pencil 95 1.99 189.05
1/23/2010 Central Kivell Binder 50 19.99 999.5
2/9/2010 Central Jardine Pencil 36 4,99 179.64
2/26/2010 Central Gill Pen 27 19.99 539.73
3/15/2010 West Sorvino Pencil 56 2.99 167.44
4/1/2010 East Jones Binder 60 4.99 299.4
4/18/2010 Central Andrews Pencil 75 1.99 149.25
5/5/2010 Central Jardine Pencil 90 4.99 449.1
5/22/2010 West Thompson Pencil | 32 1.99 63.68
6/8/2010 East Jones Binder 60 8.99 539.4
6/25/2010 Central Morgan Pencil 90 4,99 449.1
7/12/2010 East Howard Binder 29 1.99 57.71
[7/29/2010 East | | Parent Binder | | 81 19.99 'l 1,619.19
8/15/2010 East Jones Pencil 35 4,99 174.65
{ f f
TTEI Gl ¥~ T = 1% i i, BREEE MIErespft Bsced” ST TS e el
A = L reame | tnsert  Page tavois l"armulart‘_}‘_ ru":'- Reviews View Add-ins < & = @ IS
=N AR - B AU Rty
1 ‘:‘":""'::' '-l == r?:.' il e ‘-;Hf:l:ﬂ:-;?" ' f:?‘:‘?.' K. i = fll l f- k
S T ey ) B B
:_:-,j_ﬂﬁw_f__*,‘__n ST ASTNSL TN RPN YRR . <iovi s [ ERSIL DIRAE] DIERS e TR NG S =}
’ Tﬁ: Ordartate |Region Nep reem Unitw Unit Cost |Tatal l: :
s | a/8/2010|East lonas “arnvctl 25 1.99 189.03 i
7 1/238/2010|Cantral WKivall Bindear 50 19.99 299 S s iy
: T8 Z/9/2010|Central__|imrdina __|Sancy) EY:) ) 179.63 |
= 2720/2010|cantral |Gl Cwny 27 19.99 539.73 '
:_"9 3/15/2010|WwWest Sorvino__|eencll s 2.99 167.a4 |
| 31 a/3/z010|east joneas Bincar 50 a.99 299.4 | ':
a3 4/18/2010|Cantral Ancdrews ||[Pencl 75 1.99 149,23 k
‘ 23 | s/s/z030|Cantral_|lardine _ [Pane B0 299 aas.1 1 :
|32 e orelrea—|iona [uiaer s I
_.::4 : 25 2::3 :!:-n!rpl Mor'-; Pancll D0 a4.99 489.1 i H
“as 7/29/2010 '-'ff'}"*"" %—%: :: 1;:23 1,;::: :: ‘ ‘i
19 | U‘:é!zogf [East jones 2ancil B3 4,99 174.63 ! Q
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CREATE WORKSHEET IN EXCEL 2010
Creating New Worksheet

Three new blank sheets always open when you start
ksheet if you want to start another new workshee

pened worksheet and want to start a new worksheet.

Microsoft Excel. Below steps explain you how to

create a new wor t while you are working on a worksheet,

or you closed an already 0,

Ton Cedsr
N - b
sErereas

Step 2 — Now you'll see the Insclrt dialog with select Worksheet option as selected from the general tab.

Click the Ok button. - '
i
= = e T T x
rweve HEESRE o ogiidiigise s 8 R I X e |

R T e TIsE \ - .

Gerersl | sovesdshaet Sokationy | -

Chart MS Exoe] 4,0 M9 Eeoed 5.0
Moo Ovmiog
Praview rot avalsebia.

J [ o< [ cances f

R4

Ni
ow you should have your blank sheet as shown below ready to start typing your text
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You can use a short cut to create a blank sheet anytime. Try using theShift+F11 keys and you will see a

new blank sheet similar to the above sheet is opened

DELETE WORKSHEET IN EXCEL 2010

Delete Worksheet
Here is the step to delete a worksheet.
Step — Right Click the Sheet Name and select the Delete option.

=) ,-_::‘ e A

_»3

el

Sheet will get deleted if it is empty, otherwise you'll see a confirmation message: ;

(o1 kel =¥ ~ € ~iw T - Reokl - Misresaft Fxcel T=1eu)]_ =1
riames | tnsem  Papwlaysut  Roteiuias  Duta  Ravee  View  Add-e < €F o= =A w8
vl W mmy Tpum| S Ganerm i A ! @y :

P Cakibrl 'il‘-,
o s U - A AT | EE EE EE B LA ==
ey d | | |
iR e R R - lﬂ-w;,c-- | mer e J"'?"""-'"
Capbcar O " ey I At nmarr Ca i bdvisanay i |

- =]

| it A1 Shpas2 _Bhuey) S UGNENLD, RS u&! L ——— ‘ u\.‘.' :+L\1v.
Press the Delete Button,

Now your worksheet will get deleted,
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INSERT DATA IN EXCEL 2010
In MS Excel, there are 1048576*16384 cells. MS Excel cell can have Text, Numeric value or

formulas. An MS Excel cell can have maximum of 32000 characters

Inserting Data
For inserting data in MS Excel, just activate the cell type text or number and press enter or Navigation

keys.

TR A RS IR ey T R e S G R R e R
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Active cell foy inserting data

S
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b
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Inserting Formmla
For inserting formula in MS Excel go to the formula bar, enter the formula and then press enter or

navigation key. See the screen-shot below to understand it. |

i i
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—

{
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Modifying Cell Content ‘
For modifying the cell content just activate the cell, enter a new value ard then press enter or navigation

key to see the changes. See the screen-shot below to understand it.
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MOVE DATA IN EXCEL 2010
Let us see how we can Move Data with MS Excel,
Step 1 — Select the data you want to Move. nght Click and Select the cut option.
: {,ﬂ;ﬂm.s!‘lﬂ'—‘
et
2
L
‘4
5 1°
e
z
5
o _ Selectihe datawlmmu . S Betten : ; E:|
5551
i
IR
e
f‘hﬁ»‘i‘
Step 2 — Select the first cell where you want to move the data. Right click on it and paste the data. You
can see the data is rpoved now, ; ; {
f i f i
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COPY & PASTE IN EXCEL 2010

MS Excel provides copy paste option in different ways. The simplest method of copy paste is as below.

- www.Jntufastupdates.com
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Copy Paste
To copy and paste, just select the cells you want to copy. Choose copy option after right click or
press Control + C,

Select the cell where you need to paste this copicd content. Right click and select paste option or

press Control + V.
LXT & 8 0~ w L D L i memat pwbiprk ke - KA Lt i T ST e el
m marm | Wt Praeluead Pemmsel  Gms Beers e Orvoman o er BT
A Cveen v v " L Geeme ¢ Flcsadmars fermebing ¢ Jeboran ¢ 1d )
G s we X miEEGE] e s Senels s b T g |
TP e DA e w1 o o tas - Ehremme | e JEIR Lm0 |
Drreve o [d R L e I T frites, Voo Padmg | n
WAL' W v b 3 1Lk h.l-f ‘MWM & :‘
197) PRSI0 L RN TSR F R 210 IPIN TR WA+ ety id KAdd ki L e SAZI b 4 PN TRIRE 2R
[ .-
27 satary CaRulyne Salary Caieale or
EBL Y Mama Satary Amoust tam L 7T el uuvymn- iz
3 3 M oow % 000
i ¥ 2 e 36030 Fohe
i F T .
k& )
e lu;htcnrlmd paste of press Control + V )
h 10} . ] y
M Selectthe cellsta copy. Rlght click and mworpceu Control+C
al
A
1

In this case, MS Excel will copy cverything such as values, formulas, Formats, Comments and validation.
MS Excel will overwrite the content with paste. If you want to undo this, press Control + Z from the
keyboard. '

-
)

Copy Paste using Oﬂ" ce Clipboard . ( a:

When you copy data in MS Excel, it puts the copied content in Windows and Office Clipboard. You can
view the clipboard content by Home — Clipboard. View the clipboard content. Select the cell where you
need to paste. Click orl paste, to paste the content, f i
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Copy Paste In Special way
You may not want to copy everything in some cases. For example, you want to copy only Values or you

want to copy only the formatting of cells, Select the paste special option as shown below.
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Below are the various options available in pnste special:
All — Pastes the cell‘s contents, formats, and data \nhduhon from the Windows Cl\pboard

Formulas — Pastes formulas, but not formatting,

Values — Pastes only values not the formulas.

Formats — Pastes only the formatting of the source mnge:

Comments — Pastes the comments with the respective cells.

Validation — Pastes validation applied in the cells,

All using source theme — Pastes formulas, and all formatting,

All except bordcrs Pastes everything except bordcrs that appear in the source runge N
Column Width — Pastes formulas, and also duphcntes the column width of the c0p1ed cells.
Formulas & Number Formats — Pastes formulas and number formattmg only.

Values & Number Formats — Pastes the results of formulas, plus the number. ¢

FIND & REPLACE IN EXCEL 2010

MS Excel provides Find & Replace option for finding text within the sheet.

Find and Replace Dialogue
Let us see how to access the Find & Replace Dialogue.

To access the Find & Replace, Choose Home — Find & Select — Find or press Control + F Key. See the
image below.

125

1

www.Jntufastupdates.com
Scanned with CamScanner



RS R St dnaadd e R T St A ’
e o 2. vreendie g’ bV
T —— el T s iwed WL . g
— B

b Bin ps B i e
] \
W i

P
¥ ]
H 53
E i .
i
i
34

LICRsE,

el
0
"w
-
CRNE Sa e L Bk T el
Pl eah : PP : x

Ay 4 | !‘..'..‘..Zu e

e
(300 b =270

You can see the Find and Replace dialogue as below.
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You can replace tlru_,i found text with the new text i;i,rthc Replace tab. | i
i |
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Exploring Options

Now, let us see the various optiors available under the Find dialogue.
Within — Specifying the search should be in Sheet or workbook.

Search By — Specifying the internal search method by rows or by columns,
Look In — If you want io find text in formula as well, then select this option.

Match Case— If you want to match the case like lower case or upper case of words, then check this
option.
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Match Entire Cell Content — If you want the exact match of the word with cell, then check this option.
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CREATING FORMULAS IN EXCEL 2010

Formulas in MS Excel

Formulas are the Bread and butter of worksheet. Wxthout formula, worksheet will be just simple tabular

representation of data. A formula consists of special code, which is entered into a cell. It performs some

calculations and returns a result, which is displayed in the cell.

Formulas usé a variety of operators and worksheet functions to work with values and text. The values and
text used in formulas can be located in othelj cells, which makes changing data easy and gives worksheets

their dynamic nature. For example, you can quickly change the data in a worksheet and formulas works.

Elements ?f Formulas f
A formula can consist of any of these elements =

1) Mathematical operators, such as + (for addition) and *(for multiplication)

Example: =A1+A2 Adds the values in cells Al and A2,
2) Values or text
Example: =200*0,5 Multiplies 200 times 0.15, This formula uses only values, and it always retums

the same result as 100,

3) Cell references (including named cells and ranges)
Example:
TRUE; otherwise, it returns FALSE.

4) Worksheet functions (such as SUM or AVERAGE)

SR 0A ¥
P you neqd mn nll cont: e-nt mau.h

=A1=C12 Compares cell Al with cell C12. If the cells are identical, the formula reiurns
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j éxample; =SU'M- (A-i Al?_) Adds the values in the range AL:AL2.

Creating Formula
ns with =" sign. When building

to them in the worksheet.

you need to type in the Formula Bar, Formula begi

For creating a formula
ither type in the cell addresses or you can point

formulas manually, you can €
Using the Pointing method to supply the cell addresses for formulas is often
method of formula building. you click the cell or drag through the

on Arguments dialog

casier and more powerful

When you are using built-in functions,
hen defining the function’s arguments in the Functi

cell range that you want to use W

g I i
LYY S S AT ARG PRIE Rt e

Ear ves vwrites forrvesia

=

¥

ates the result, which is then displayed inside the
i:ia visible on the Formula bar

As soon as you complete a formula entry, Excel calcul

cell within the :workshcct (the contents of the f‘ormula, however, continue to
rmula that prevents Excel from being able to

anytime the cell is active). If you make an error in the fo
calculate the formula at all, Excel displays an Alert dialog box suggesting how to fix the problem.
| i

COPYING FORMULAS IN EXCEL 2010

Copying Formulas in MS Excel
Copying formulas is one of the most common tasks that you do in a typical

primarily on formulas. When a formula uses cell references rather than constant values,

spreadsheet that relies
Excel makes the

task of copying an original for_mula to every place that requires a similar formula,

Relative Cell Addresses
MS Excel does it automatically adjusting the cell references in the original formula to suit the position of

the copies that you make. It does this through a system known as relative cell addresses, where by the
column references in the cell address in the formula change to suit their new column position and the row

references change to suit their new row position.

Let us see this with the help of example. Suppose we want the sum of all the rows at last, then we will

write a formula for first column i.e. B. We want sum of the rows from 3 to 8 in the 9" row.
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R Formula bar showing formula
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SR

ight cellsto copy formula with ralative call addressing

‘ “% Dymg this tor

After writing formula in the 9" row,
After dragging we can see the formula in the remaining columns as below.
Column C: =SUM (C3:C8)

Column D: =SUM (D3:D3)

Column E: =SUM (E3:ER)
Column F: =SUM (F3:F8)
Column G: =SUM (G3: GB)

.5‘ !F,‘
ﬂl;h-w‘_
i lgi i

we can drag it to remaining colymns and the formula gets copied.

|
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Formula bar showing formuta

-
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Copiled Formula with dragging usinl ralativa addrossing

EIRES

-
I
Al et

= e
O oche s

=
l.ﬂ_

Xy
R

_ AW e b ;M,ls,m_._w"'"’“"""' L2t Sl K "’nof—"
o B I e ,v—qugﬂ u-'-.\"'}‘:v

e e
= i

FORMULA REFERENCE IN EXCEL 2010

Cell References in Formulas

Most formulas you create include references to cells or ranges, These references enable your formulas to
work dynamically with the data contained in those cells or ranges, For example, if your formula refers to
cell C2 and you change the value contained in C2, the formula result reflects new value automatically. If

you didn’t use references in your formulas, you would need to edit the formulas themselves in order to

change the values used in the formulas.
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When vou use a cell (or range) reference in a formula, you can use three types of references — relative,

ahsolute, and mixad references.

Relative Cell Relerences
The row and column references can change when you copy the formula to another cell because the

references are actually offsets from the current row and column. By default, Excel creates relative cell
references in formulas, .
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Absolute Cell References

The row and column references do not changc when you copy the formula because the reference is to an

actual ccil address. An absolute reference uses two dollar signs in its address: one for the column letter
and one for the row number (for example, $AS5).

!A'?'_!".___fﬁ"mi [ pe——"— o P "J
e TR e e Taemeni T i e N T
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=0 g St il 4
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g e St LA LT T W o e
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Mixed Cel} References
Both the row ¥
or ¢ i g
. olumn reference is relative and the other is absolute, Only one of the addres: :
absolute (for example, SAS or AS5), HOGAIoN paris s
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USING FUNCTIONS IN EXCEL 2010

Functions in Formula

Many formulas you create use available workshee
enhance the power of your formulas and perform calculations that are difficult if
LOG or SIN function to calculate the Logarithm or Sin ratio. You

t functions, These functions enable you to greatly
you use only the

operators. For example, yoﬁ can use the
can’t do this complicated calculation by using the mathematical operators alone.

Using Functions ,
When you type = sign and then tyée any alphabet you will see the ;scarchcd functions as below.
|

starting with na

Typing PA willaby

\
e e 1 | S st

Suppose you need to determine the largest value in a range. A formula can’t tell you the answer without
using a function, We will use formula that uses the MAX function to retumn the largest value in the range

B3:B8 as =MAX (A1:D100).

._.
L=
=
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f month is greater than 1900 then we
ula with IF functions

Suppose you want to find if the cell o
we can achieve it with writing form

Another example of functions.
can give Bonus to Sales representative. The

as=IF (B9>1900,"Yes","No")

)
30 |

-
i
i
3
i
H
1
4

"

R

Function Arguments
The inforrrnation

In tlrac above examples,
inside the parentheses is the list of
Functions vary in how they use arguments. Depend
No arguments ~ Examples — Now 0, Date (), etc.

UPPER (), LOWER (), etc.
ts —IF (), MAX (), MIN 0,

you may have noticed that all the functions used parentheses.
I f

arguments.
on may use.

ing.on what it has to do, a functi

One argument ~
AVERGAGE (), etc.

A fixed number of argumen
Infinite number of arguments

Optional arguments
BUILT-IN FUNCTIONS IN EXCEL 2010

formula, To ‘see all the functions by

Built In Functions '
cars from which we can

MS Excel has many built in fun
Tab » Insert Function. The

which we can use¢ in our

ctions,
n Insert function Dialog app

category, choose Formulas

choose the function.

132

www.Jntufastupdates.com
Scanned with CamScanner



i

e

P L i
P

—-J."\ LC"'EI__UAI__.__..—_-..

s PO o -
A SPEL A S b sussiad RS S S
Yo 3 p_per mimail e L mtree WD

Functions by Categories
Let us see some of the built in functions in MS Excel,

Text Functions
LOWER — Converts all characters in a supplied text string to lower case

UPPER - Converts all characters in a supplied text string to upper case

TRIM — Removes duplicate spaces, and spaces'at the start and end of a text string
CONCATENATE - Joins together two or more text strings.

LEFT — Returns a specified number of characters from the start of a supplied text string.
MID — Returns a specified number of characters from the dedle of a supplied text string

| RIGHT - Retums a spemﬁed flumbcr of characters from the ePd of a supplied text string.

LEN — Returns the length of a supplied text string
FIND — Returns the position of a supplied character or text string from wﬂhm a supplied text smng (case-sensitive).
/ f
Date & Time
DATE — Returns a date, from a user-supplied year, month and day. .
TIME ~- Retumns a time, from a user-supplied hour, minute and second.
DATEVALUE — Converts a text string showing a date, to an integer that represents the date in Excel's date-time code.
TIMEVALUE — Converts a text string showing a time, to a decimal that represents the time in Excel.
NOW - Returns the current date & time,
TODAY ~ Returns today's date,

Statistical

MAX ~ Returns the largest value from a list of supplied numbers.

MIN - Returns the smallest value from a list of supplied numbers.

AVERAGE - Returns the Average of a list of supplied numbers.

COUNT - Returns the number of numerical values in a supplied set of cells or values,
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COUNTIF - Returns the number of cells (of a supplied range), that satisfies a given criteria. .

SUM — Retumns the sum of a supplied list of numbers

Logical

AND — Tests a number of user
TRUE, or FALSE otherwise
OR - Tests a number of user-defin

TRUE, or FALSE otherwise.
| value that is the opposite of a user supplied logical value or e

NOT — Returns a logica
returns FALSE if the supplied argument is TRUE and returns TRUE if the supplied argument is FAL

-defined conditions and returns TRUE if ALL of the conditions evaluate to

ed conditions and retums TRUE if ANY of the conditions evaluate to .

xpression i.e.

Math & Trig
ABS — Returns the absolute value (i.c. the modulus) of a supplied number.

SIGN — Retuxm the sign (+1, -1 or 0) of a supplied number.

SQRT — Returng the positive square root of a given number.
ainder from a division between two supplied numbcrs

-
5

MOD — Returns the rem
ADDING GRAPHICS IN EXCEL 2010

Graphic Objects in MS Excel
MS Excel supports various types of graphic objects like Sbi'apes gallery,
WordAxt available on the In.aert tab of the Ribbon. Graphics are available in the Insert T

screenshots below for various avail

Smart Art, Tcxtiv‘Box, and
arb.ASee the

able graphics in MS Excel 2010.
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Insert Shape
Choose Insert Tab » Shapes dropdown.
Select the shape you want to insert, Click on shape to insert it.

To edit the inserted shape just drag the shape with the mouse. Shape will adjust the shape.
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Insert Smart Art
Choose Insert Tab » SmartArt.

list of available SmartArts, ,
Click on SmartArt to Insert it in the worksheet.
Edit the SmartArt as Per your need

Insert Clip Art ,
Choose Insert Tab » Clip Art, ’

Clicking Clip Art will open the search box as shown in the below screen-shot. Choose from the list of
available Clip Arts.

Click on Clip Art to Insert it in the worksheet
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SIMPLE CHARTS IN EXCEL 2010

Charts

A chart is a visual féprescntntion of numeric values. Charts (also known as graphs) have been an integral
part of spreadsheets. Charts generated by carly spreadsheet products were quite crude, but thy have
improved significantly over the years, Excel provides you with the tools to create a wide variety of highly
customizable charts. Displaying data in a well-conceived chart can make your numbers more
understandable. Because a chart prescnlé a picture, charts are particularly useful for summarizing a series

of numbers and their interrelationships.

Types of Charts

There are various chart types available in MS Excel as shown in the below screen-shot.
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Column — Column chart shows data changes over a perjod of time or illustrates comparisons among

items,

Bar — A bar chart illustrates comparisons among individual items.

Pie — A pie chart shows the size of items that make up a data series, proportional to the sum of the items.
It always shows only one data series and is useful when you want to emphasize a significant element in
the data. '

Line — A line chart shows trends in data at equal intervals.

Area — An area chart emphasizes the magnitude of change over time.

X Y Scatter — An xy (scatter) chart shows the relationships among the numeric values in several data
series, or plots two groups of numbers as one serics of xy coordinates, .

Stock — This chart type is most often used for stock price data, but can also be used for scientific data (for
example, to indicate temperature changes),

Surface — A surface chart is useful when you want to find the optimum combinations between two sets of
data. Asin a topographic map, colors and patterns indicate areas that are in the same range of values.

Doughnut ~ Like a pie chart, a doughnut chart shows the relationship of parts to a whole; however, it can
contain more than one data series,
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‘ Bﬁbﬁlé —'.I‘J-at'a that is arranged in 'c“o]'(n'nnvs on a worksheet, so that x values are listed in the first column
and corresponding y values and bubble size values are listed in adjacent columns, can be plotted in a

bubble chart.
Radar — A radar chart compares the aggregate values of a number of data series.

Creating Chart

To create charts for the data by below mentioned steps.

> Select the data for which you want to create the chart.

> Choose Insert Tab » Select the chart or click on the Chart group to see various chart types.

> Select the chart of your choice and click OK to generate the chart.
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Editing Chart i ¥
You can edit the chart at any time after you have created it. : f
You can select the different data for chart input with Right click on chart » Select data. Selecting new data
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You can change the X axis of the chart by giving different inputs to X-axis of chart,
You can change the Y axis of chart by giving different inputs to Y-axis of chart.

-
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PIVOT CHARTS EXCEL 2010

Pivot Charts

A pivot chart is a graphical representation of a data summary,
ghways based on a pivot table. Alithough Excel lets you create a pivot table and a pivot chart at the same
ot table. All Bxcel charting features are available in a

displayed in a pivot table. A pivot chart is

time, you can’t create a pivot chart without a piv
pivot chart.

Pivot charts are available under Insert tab » PivotTable dropdown » PivotChart.

Pivot Chart Example

Now, let us see Pivot table with the help of an example. Suppose you have huge data of voters and you
want to see the summarized view of the data of voter Information per party in the form of charts, then you

can use the Pivot chart for it. Choose Insert tab » Pivot Chart to insert the pivot table.
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MS Excel selects the data of the table. You can select the pivot chart location as an' existing sheet or a
new sheet. Pivot chart depends on automatically created pivot table by the MS Excel. You can generate
the pivot chart in the below screen-shot.
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